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ZLS50110/1/4 Demonstration Software User Guide
1.0    Introduction / Overview
This document describes how to use the ZLS50110/1/4 Demonstration Software to control, configure and
demonstrate the capabilities of the ZLE50110/1/4 evaluation board and the ZLS0110/1/4 CES-over-Packet
processor chip. It covers the communication protocols used, how to register and configure multiple evaluation
boards, how to run set-piece demonstrations, and how to define and establish data links and clock recovery
between ZLS0110/1/4 chips.

For instructions on how to install and setup the demonstration software suite, refer to the separate “ZLE50110/1/4
System Installation Guide”.

2.0    Demonstration System Components
The ZLS50110/1/4 Demonstration System is made up of two main entities:

• The ZLS50110/1/4 Management Station running on a PC.

• The ZLS50110/1/4 Embedded Agent running on one or more ZLE50110/1/4 Evaluation Boards
The management station is a program which allows its user to communicate with and control one or more agents.
The primary management communication protocol used is the popular standard SNMP (Simple Network
Management Protocol). SNMP allows the user to browse a pre-defined tree structure to exchange information and
also to configure/control the evaluation application (this is explained further in Section SNMP and MIBs). 

Zarlink has also developed a proprietary protocol called ZLink. The ZLink protocol allows complex data to be
passed between entities, and also allows scripts (called ZScripts) to be encoded into packets, which allow the user
to remotely call software functions on the embedded agent (This is explained further in “ZScripts” on page 69).

3.0    SNMP and MIBs
In order for the management station and the agent to communicate using SNMP, they have a common data tree
called an MIB (Management Information Base), which defines the information that can be passed between the two.
The tree is described by a number of files in ASN.1 (Abstract Syntax Notation) language.

3.1    Registering Agents

To establish communication between the management station and an agent using SNMP, the agent must first be
registered with the management station.There are two ways of doing this, auto-registration and manual registration.

3.1.1    Auto-registration

When an agent is powered up, it initializes its MIB and then sends an SNMP coldstart trap packet to all of the
management stations in its management station table. The management station table is a database stored on the
agent which defines which management stations it can communicate with. If a management station receives one of
these packets, it will automatically register the agent and obtain some initial configuration information from it. The
user will be aware of this because a window will pop up displaying the MIB tree for the new agent. To use
auto-registration, the user must ensure that the management station software is running on the PC when the board
is powered on, and the IP address of the management station must be in the management station table on the
agent.

When a recognised agent (e.g. the ZLE50110/1/4 evaluation board) is registered with the management station , a
customised configuration dialog will also appear which allows the user to configure the agent more easily than
browsing through the tree. This is described in detail later in “Agent Configuration Dialogs” on page 12.
6
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3.1.2    Manual Registration

If an agent is already powered on and running before the management station program is run, the agent can still be
registered manually. To achieve this, the user must click on the ‘Agents’ button or select the menu File -> New ->
Agent. A manual registration dialog (see Figure 1) will then appear into which allows the user to specify a transport
method, and transport parameters. 

This dialog also allows the user to register remote agents, which are communicated with via a proxy agent.The
proxy agent uses remote signalling to forward packets to the remote agent.

Please note: To communicate with an agent using the serial port, manual registration must be used.

Figure 1 - Manual Registration Configuration

The items in the network section of the manual registration configuration are:

• Local Network - Selects the creation of a Local Network Agent.

• Remote Network - Selects the creation of a Proxy Agent to reach remote device.
• Agent IP Address - (Local Agent) Enters the IP address of the Agent on the target ZLS0110/1/4 board.

• Proxy Agent IP Address - (Agent for Remote) Enters the IP address of the Agent on the target ZLS0110/1/4 
board to use as a proxy to reach the remote device. This can be the same as auto-registered local Agent.

• Agent UDP Port - (Local Agent) Enters the UDP port of the Agent on the target ZLS0110/1/4 board.
• Proxy Agent IP Address - (Agent for Remote) Enters the UDP port of the Agent on the target ZLS0110/1/4 

board to use as a proxy to reach the remote device.
• Remote Agent - Drop down dialog allows the user to select from a list of pre-defined of remote agents 

(defined in the “The Remote Device Table” on page 9), or to enter the remote agent address manually. 
• Remote MAC Address - Enters remote signalling MAC Address of the target remote device.
7
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• Remote IP Address - Enters the remote signalling IP Address needed to reach the target remote device.
• Remote UDP Port - Enters the remopte signalling UDP port required reach the target remote device.

• Remote Device ID - Enters a device ID to use for the target remote device.
The items in the Serial Communication section of the manual registration configuration are:

• Use Serial - Selects the creation of a serially linked Agent.

• Serial Port - Drop down dialog provides serial port selection.This is PC dependent and is of the form 
‘COM1’,’COM2’.

• Baud Rate - Selects serial port speed at one of the standard rates. Default 115200bps.

3.2    Browsing the MIB Tree

There are four different types of node on the tree, distinguished by different colours:

 - Yellow. This is a branch node. The node has no data value, but potentially has child nodes.

 - Green. This is a leaf node with a read/write data value.

 - Red. This is a leaf node with a read-only data value.

 - Blue. This is a table branch node. Indicates that the branch underneath it is an SNMP table.

When a node is selected, its OID (Object ID), node name, data type, minimum value and maximum value are
displayed on the status bar. Additional MIB tree browser window can be created (useful for viewing different
sections of the tree simultaneously), by selecting the menu item Tools -> Browse MIB Tree.

The title bar of the window displays the transport address of the agent.

For more information on SNMP see RFC1905 Protocol Operations for Version 2 of the Simple Networking Protocol.

Figure 2 - MIB Tree View
8
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3.3    Getting and Setting Node Values

To get the current data value of a node on the tree from the agent, either select the node and use the menu item
Tools -> Get Node Value, or right-click on the node and select Get Value from the pop-up menu. Only applies to
red and green nodes.

To set the data value of a node on the tree, either select the node and use the menu item Tools -> Set Node Value,
or right-click on the node and select Set Value from the pop-up menu. An edit box will then appear over the
selected node which the new value can be typed into. Only applies to green nodes.

To get the data values of a block of nodes in one go, either select the first node in the block and use the menu item
Tools -> Get Bulk or right-click on the node and select Get Bulk from the pop-up menu. A small dialog box will
then appear which allows the user to choose how many nodes to retrieve. Works on all types of node.

The SNMP command Get Next is also supported, and is used in the same way as Get, except that it can be used
on any type of node and will get the data value of the next node with data on the tree.

3.4    Synchronising Branches of the Tree

It is possible to synchronise an entire branch of the tree, either to or from the agent. To do this, right-click on the
branch node to synchronise select either Sync Branch From Board or Sync Branch To Board. A sequence of
SNMP packets will then be sent to perform this operation.

4.0    The Remote Device Table
When establishing data links between ZLS0110/1/4 devices, it is possible to create links to and from devices that
are not under the direct control of the management station - these are referred to as remote devices.
Communication to and from remote devices is achieved by sending signalling packets using a ZLS0110/1/4 device
on a proxy agent. The remote device table is used to populate the ‘Remote Agent’ drop down selection in the
‘Manual Registration’ dialog.To edit the remote device table, select Tools -> Edit Remote Device Table. A
screenshot of the remote device table is shown in Figure 3.

Figure 3 - Remote Device Table
9
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The user must first specify a name for the device, which will be used in the drop-down boxes, then the device ID
and MAC addresses of the data ports. The user must also specify which of the MAC ports to use remote signalling
packets, and the IP address and UDP port of the device.

A summary of the items in the ‘Remote Device List ‘dialog are:

Device List display - Shows all the remote devices set up in the system. Click on <new> to add another entry to
the system. The remote device list shows a summary of all the information that can be entered in the entered the 

Name - Enters a name to use for the remote device, which can be used for subsequent device selection. 

Device Id - Enters a remote device ID to used to reference the device. Should be unique for each agent in the
system.

IP Address - Enters the remote signalling IP address to be used to reach the remote device.

UDP Port - Enters the remote signalling UDP port to be used to reach the remote device.

Port n MAC Address - Enters the MAC addresses of all 4 network ports on the remote ZLS0110/1/4 device (n=
0-3).

Update Device - Button applies the configuration changes to the ZLE50110/1/4 board. 

Copy Device - Button produces a new entry in the remote device list with the settings of the selected device.

Remove Device - Button removes the selected device from the ‘Remote Device List’.

Remote Signalling Port - Drop down selects one of the 4 MAC ports for remote signalling.

5.0    Peripheral Profiles and Jumper Settings
Before any data can be transferred using the ZLE50110/1/4 board and ZLS50110/1/4 software, the data routing and
clock configurations must be set. This is done by setting jumpers on the board and loading a peripheral profile
which matches the selected mode. The following subsections describe the options available. Select the required
mode of operation for the intended links, set the board jumpers and move on to the “Agent Configuration Dialogs”
on page 12. 

Note. The standard demonstrations use the profile and jumpers for ST-BUS Slave 8Mb/s mode. This mode limits
the number of TDM streams to 8, each with 128 channels.

5.0.1    ST-BUS Slave Operation 8Mb/s

In this mode the ZLS0110/1/4 WAN interface is set up to communicate with MT90869 switch on the motherboard
without using LIU or Framer devices. It is selected when running links which use the MT90869 BER for data tests or
the MT92303 codec for audio tests. (The codec is reached via the MT90869 switch.) This is also the standard
configuration for the ‘set piece’ demonstrations in the ZLS50110/1/4 software.

The required Peripheral Profile file is ‘stbus_slave_8mbit’.

Required clock link settings are shown in Figure 4:

J71 J73 J74J45 J47 J75

. . . .
..
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Figure 4 - ST-BUS Slave 8Mb/s Jumper Settings

5.0.2    ST-BUS Slave Operation 2Mb/s

This mode is the same as ‘ST-BUS 8Mb/s’ except the WAN interface is set to run at 2Mb/s with the clock running in
x 2 mode. (4Mb/s). The jumper settings are different to the 8Mb/s mode because the data comes from the MT90869
and the clock comes from the MT90401 chip.The required Peripheral Profile file is ‘stbus-slave-2mbit’.

Required clock link settings are shown in Figure 5:

Figure 5 - ST-BUS Slave 2Mb/s Jumper Settings

5.0.3    LIU Mode E1/T1

In this mode data from the LIU is routed directly to the ZLS0110/1/4 in full streams with no framing. The WAN
interface is set up for 2.048Mbits un-structured mode for E1 and 1.544Mb/s for T1. This LIU mode allows external
test equipment to provide test data for the ZLS0110/1/4 on the ZLE50110/1/4 board. The test data is transparent to
the ZLS0110/1/4 so can have any structuring or test pattern applied.The required Peripheral Profile file is ‘liu-e1’ or
‘liu-t1’.

Required clock link settings are shown in Figure 6:

Figure 6 - LIU Mode E1/T1 Jumper Settings

5.0.4    Framer Slave Mode

In this mode the LIU data (digital side) is routed to the ZLS0110/1/4 chip via the MT9072 framer. The MT9072 chip
detects any E1/T1 framing and puts the decoded data channels to ZLS0110/1/4 WAN interface. This mode can be
used to supply selected channels from an external TDM stream attached to the LIU. (Rather than use whole
streams with the LIU mode.) The ZLS0110/1/4 operating in ‘Slave’ mode gets it’s clock and frame pulse from the
MT90401 chip.

The required Peripheral Profile file is ‘framer_slave_e1’ or ‘framer_slave_t1’ depending on the required line rate.

Required clock link settings are shown in Figure 7:

J71 J73 J74J45 J47 J75

. . . .
..

J71 J73 J74J45 J47 J75

. . . .
..
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Figure 7 - Framer Slave Mode Jumper Settings

5.0.5    Framer Master Mode

The ‘Frame Master’ mode is the same as the ‘Frame Slave’ mode except the ZLS0110/1/4 chip derives its own
clock and frame pulse using a master clock from the MT90401 chip. The required Peripheral Profile file is
‘framer_master_e1’ or ‘framer_master_t1’ depending on the required line rate.

Required clock link settings are shown in Figure 8:

Figure 8 - Framer Master Mode Jumper Settings

5.0.6    Reverse Framer Mode E1/T1

In this mode BER test data from the MT9072 framer, which would normally be transmitted to the LIU,is routed to the
ZLS0110/1/4 chip to provide multi-stream test capability. The jumper settings for this mode are the same as ‘LIU
E1/T1 Mode’. The peripheral file is slightly different making adjustment to clock polarity settings.

The required peripheral profile is ‘reverse_framer_e1’ or ‘reverse_frame_t1’ depending on the required line rate.

6.0    Agent Configuration Dialogs
When an agent is registered, a dialog box appears which allows the user to configure various options for the
ZLE50110/1/4 evaluation board, the ZLS0110/1/4 chip, and the demonstration software itself. The dialogs are
arranged in a tab structure – each tab is described in the following sections. The buttons at the bottom of the
window allow the user to apply changes to the agent, or to apply changes and save, which will causes the
configurations to be saved into the non-volatile memory on the agent so that they can be reloaded after the agent is
reset. Note that each tab dialog has a ‘discard changes’ and ‘refresh from agent’ button which apply to each one
individually. 

One of the key actions required before ANY demonstration or link can be run, is to load a ‘Peripheral Profile’ and
then ‘Initialize the Agent’ -this is done in the ‘Peripherals Tab’. To see the choice of peripheral files and their
matching board jumper settings see “Peripheral Profiles and Jumper Settings” on page 10.

J71 J73 J74J45 J47 J75

. . . .
..

J71 J73 J74J45 J47 J75

. . . .
..
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6.1    Management Station Table

The management station table defines which management stations the agent can communicate with. Also, the
agent will attempt to auto-register with all of the management stations in the table that are in use when it is powered
up. The dropdown box at the top of the dialog allows the user to select which entry in the table to view/edit.

Figure 9 - Management Stations Configuration Dialog Screenshot

The items on this dialog are:

• In Use – Tick box specifies whether the currently selected entry is in use. If not, the agent will ignore this 
entry.

• Transport Type – Drop down dialog enters the communication method to use with to the management 
station, either network or serial.

• IP Address – Enters the IP address of the management station (only applies to network mode).
• SNMP Port – Enters the UDP port on the management station to send normal SNMP packets (network 

mode only).
• Trap Port – Enters the UDP port on the management station to send SNMP trap packets to (network mode 

only).
• Serial Baud Rate – Enters the speed of the serial connection (serial mode only).

• SNMP Last Rid – Shows the request ID of the last packet received by the agent for this management 
station.
13
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6.2    SysLog Configuration

The syslog tab shown in Figure 10,allows the system logging information that is sent from the agent to be
configured. When using network mode, system logging information is sent using UDP packets to a PC which is
running an instance of the Zarlink System Logger program. In serial mode, system log information is sent out of the
RS232 port and must be captured using a third party program such as Hyperterminal.

Figure 10 - Syslog Dialog

The items on this dialog are:

• Syslog Mode – Drop down dialog specifies whether system log information is sent over the network, serial, 
or turned off.

• IP Address – Enters the IP Address of the PC to send syslog packets to (network mode only).

• Port – Enters the UDP port to send debug packets to (network mode only). An instance of the Zarlink 
System Logger program must be listening on this port in order for the syslog information to be captured.

• Discarded String Count (read-only) – This count increments if the syslog buffers overflow when a log string 
is written to them, causing information to be lost. The count also increments if strings are written to the 
syslog buffers when the ‘Syslog Mode’ is set to off.

• Debug Level – Specifies which modules within the embedded agent have system logging enabled. Check 
whichever sections of messages that you want to retrieve.
14
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6.3    OBRS Lookup Table Configuration

Out-of-band remote signalling is a mode which allows signalling packets to be sent directly from agent to agent over
the management network rather than using the ZLS0110/1/4 to send them. In order for this to work, a mapping
must be provided that converts ZLS0110/1/4 MAC port addresses into IP address/UDP port for use on the
management network - this mapping is known as the Out-of-band remote signalling (OBRS) table. This dialog
allows the OBRS table to be configured (See Figure 11).To add/edit an entry in the table, first select a slot from the
list, type in the details in the boxes at the bottom of the dialog, then press Apply to update the table. To enable
OBRS mode, see the Remote Signalling Configuration tab.

Figure 11 - OBRS Lookup Table Configuration Dialog 

The items on this dialog are:

• In Use – Tick box specifies whether or not the selected entry is in use.
• MAC address – Enters the MAC address that will be mapped.

• IP Address – Enters the IP address of the agent to send the OBRS packets to.
• Port – Enters the UDP port of the agent to send the OBRS packets to.

• Discard Changes - Button discards changes without saving.
• Refresh from Board - Button gets and displays the OBRS parameters from the ZLE50110/1/4 board.
15
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6.4    Peripheral Configuration

The peripheral configuration tab sets up the operating modes for all the peripheral devices which are needed to
support the ZLS0110/1/4 chip (See Figure 12). In particular, the TDM buses and clock settings which link the key
devices together. During system initialization, the peripheral cards and devices are auto-detected. All the detected
devices are listed and can be configured individually using drop down dialogs. The jumpers on the ZLE50110/1/4
board have to be set to match the chosen peripheral device settings. (see ZLE50110/1/4 Board User Guide).

For most users, it is advisable to load a ‘Peripheral Profile’ which stores a complete configuration for the peripheral
devices on the board. To do this use the ‘Load Profile’ button to load the file and then use the ‘Initialize Agent’ to
program the devices. It is advisable to set the board jumpers before initializing the agent.

For information on the complete set of ‘Profiles’ along with the required board jumper settings see “Peripheral
Profiles and Jumper Settings” on page 10.

Alternatively, if only the standard locally managed demonstrations are required, go to the “Quick Start Demo
Example,” on page 33. This section shows which profile to load and the correct board jumper settings.

Figure 12 - Peripheral Configuration Dialog

The peripheral configuration items are:

• Card List - Shows a list of detected cards and their slots. If a card is highlighted, it’s devices are shown in 
the ‘Devices List Dialog’.

Note. Card 869 in Slot 0 refers to a set of devices on the motherboard.

• Devices List - Shows a list of devices in the slot highlighted in the ‘Card List Dialog’.This display also shows 
the device ID and initialization status (‘Initialized YES/NO’). At the same time, configuration options are 
shown in the ‘Device Options List Dialog’.
16
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• Device Options List - Shows the list of configurable options for the selected device. If one of these options 
is highlighted, then the allowed configuration values are shown on the ‘Device Option’ drop down. ( Or an 
entry box if a numerical entry is required. )

• Device Option - Drop down dialog or number entry box provides parameter value selection, depending on 
the device parameter selected in the ‘Device Options List’.

• Discard Changes - Button discards parameter changes without saving.

• Refresh From Board - Button reads the device parameters from the ZLE50110/1/4 board and display the 
values in the ‘Device Options List’.

• Save Profile - Saves the present settings to a file on the management station.
• Load Profile - Loads a pre-stored ‘Peripheral Profile’ file from the management station. This is the 

recommended way of getting links and demonstrations running quickly. 

6.5    LAN Configuration

Figure 13 - LAN Configuration Dialog

This LAN configuration tab allows the user to configure the LAN ports on the ZLS0110/1/4 (Figure 13). The items on
this dialog are:

• Device - Drop down dialog selects the ZLS0110/1/4 device to receive the LAN configuration.
• Port Num - Drop down dialog selects the port to configure. Options are ‘0 - 3’.

• MAC Type - Drop down dialog selects LAN port type, options are ‘MII’,’GMII’,’PLS’, ‘NO CARD’.
The MAC type is auto-detected so the user should leave this as default or select ‘NO CARD’.

• MAC Address - Enters the MAC address for the selected LAN port.
17
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• Max Packet Length - Enters the maximum packet length for packets to be received on the LAN port.
• Filter Broadcast Pkts - Tick box enables the MAC broadcast packet filter on the LAN receiver (Not available 

with the ZLS0110/1/4 ‘A’ chip).
• Filter Multicast Pkts - Tick box enables the MAC multicast packet filter on the LAN receiver (Not available 

with the ZLS0110/1/4 ‘A’ chip).
• Filter non-matching Unicast Pkts - Tick box enables the MAC filter on the LAN receiver. The MAC only 

allows packets with the MAC address matching the LAN port to pass through to the ZLS0110/1/4 Pattern 
Matching system (Not available with the ZLS0110/1/4 ‘A’ chip).

• VLAN enabled - Tick box to enable VLAN in the MAC block.
• Enable 64-bit MAC Stats - Tick box enables 64-bit MAC Stats.

LAN Rx Queue parameters (for more information on these ZLS0110/1/4 queue parameters see the ZLS0110/1/4
Programmers Model):

• Priority Mode - Drop down dialog selects the packet receive queue priority mode. Allowed options ‘1 to 0’, ‘2 
to 0’, ‘None’, and ‘All’.

• Queue to Config - Drop down selects the queue to configure, allowed selections queue 0 - 3.
• Granule Threshold Drop Packets - Tick box to select an option where packets are dropped if the back log 

of packet granules exceeds the ‘Granule Threshold’ (Packet overflow).
• Granule Threshold - Enters the number of packet granules in the LAN receiver, triggerring an overflow 

condition for the ‘Granule Threshold Drop Packet’ mode.
• Priority Weighting - The priority value for the port in the range 0-63 when using ‘Weighted Fair Queuing 

Mode’.

For more information on these parameters see the LAN sections of the ZLS0110/1/4 API User Guide.
18
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6.6    Demo Configuration

The demo configuration shown in Figure 14, sets parameters in the ZLS0110/1/4 chip which are common to all the
demonstrations featured in the ZLS50110/1/4 software.

Figure 14 - Demo Configuration Dialog

The items in the Demo configuration dialog are:

• Device - Drop down dialog selects the ZLS0110/1/4 device to receive the Demo configuration. If only one 
device is present, the option is fixed at zero.

• Frames per packet - Enters the required number of TDM frames to be included in the transmitted packet. A 
value of 2, for example, would mean that every packet includes the data from 2 TDM frames for all included 
timeslots. 

• Context Header Queue - Drop down dialog selects the queue for packet construction, allowed values 0 - 3.

• CPU Queue - Drop down dialog selects the CPU queue for packets to the host, allowed values 0-3.
• Jitter Buffer Size - Enters the size of the packet receive jitter buffer in micro-seconds.

• WAN Tx Queue Size - Drop down dialog selects the queue size for packet receiver, allowed values 2 - 1024 
in powers of 2.

• WAN Tx Queue Mode - Drop down dialog selects the queue method to be used for the packet receive 
buffer. Options: ‘FIFO’ - no packet resequnecing, ‘Resequence 8’ - resequencing on 8 bit packet numbers 
and ‘Requence 16’ - resequencing on 16 bit packet numbers.

• WAN Tx Queue Avg Mode - Drop down dialog selects the queue average mode. This allows CET timing 
data in each packet to be hardware averaged before being processed by the software CET algorithms. This 
parameter sets the number of packets to be averaged (Range 2 - 65536 in powers of 2).
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• WAN If Underrun Mode - Drop down dialog selects the WAN character to be transmitted in the event of a 
LAN packet underrun. Options are ‘Use Fixed Byte’ and ‘Use Last Byte’.

• Underrun Byte - Enters the byte to be transmitted on the WAN port during a LAN Rx packet underrun (If 
‘Use Fixed Byte’ option is selected).

• Layer 5 Timestamp Increment - Enters the count increment to be used in the layer 5 (E.g. RTP) timestamp.

6.7    Remote Signalling Configuration

The remote signalling dialog shown in Figure 15, configures the remote signalling parameters for devices to be
used with remote chip to chip communication. This remote signalling uses the CPU->LAN and LAN->CPU features
of the ZLS0110/1/4 chip in conjunction with the Ethernet2\IPV4\UDP protocol. The remote signalling IPV4 address,
UDP port and MAC port is set in this dialog. The MAC addresses for the ports are set in the ‘LAN’ configuration
dialog.

Devices on other ZLE50110/1/4 boards, trying to reach one of these devices, must have matching parameters
programmed into their ‘Remote Device Agent’ (See “Manual Registration,” on page 7).

Figure 15 - Remote Signalling Dialog

The items on this configuration are:

• Device - Drop down dialog selects the ZLS0110/1/4 device to receive the remote signalling configuration. If 
only one device is present, the option is fixed at zero.

• Enable Out-of-Band Signalling - Tick box selects the out of band remote signalling mode, which uses the 
network management network, for communication rather than the chip to chip signalling. This feature is 
configured in the “OBRS Lookup Table Configuration,” on page 15.

• RS MAC Port - Selects the physical MAC port to be used by the selected device for remote signalling.
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• IP Address - Enters an IP address to be used for remote signalling with the selected device (Entry format 
134.199.77.110).

• UDP Port - Enters a UDP port number to be used for remote signalling with the selected device.
• Tx Queue Number - Drop down dialog selects the remote signalling transmit queue to use with the selected 

device (Allowed range 0-3).
• Rx Queue Number - Drop down dialog selects the remote signalling receive queue to use with the selected 

device (Allowed range 0-3).
• Priority - Enters the queue priority for the selected device (Default 0).

6.8    Context Database Configuration

The context database dialog shown in Figure 16, provides default settings for the fields in the context database.
The base values are entered in this dialog and values are selectively auto-incremented, to produce a set of values
for each context. (see “Auto Increment Configuration,” on page 39 for more information). The generated protocol
parameters are designed to allow each context to be distinguished and routed by a receiving ZLS0110/1/4 chip.
The context database is set up with routing parameters for each context and device and must be initialized with
different values for each board in the system.The ‘Context Database Editor’ should be used if more control is
required on context routing parameters (See section “Context Database” on page 41).

Figure 16 - Context Database Dialog

The items in the dialog are:

• Device - Specifies the ID of the ZLS0110/1/4 device whose data base is being referenced.

The protocol routing fields in the dialog are listed below and their auto-increment values are shown. 

• VLAN ID - No auto-increment
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• IPv4 Time To Live - No auto-increment.
• IPv4 Source Address - No auto-increment.

• IPv4 Dest Address - No auto-increment.
• MPLS Label - Auto-increment +1.

• UDP Source Port - Auto-increment +2.
• UDP Dest Port - Auto-increment +2.

• L2TPv2 Session Id - Auto-increment +1
• L2TPv3 over UDP Session Id- Auto-increment +1

• L2TPv3 over UDP Cookie - Auto-increment +2
• L2TPv3 over IP Session Id - Auto-increment +1

• L2TPv3 over IP Cookie - Auto-increment +1
• RTP SSRC - Auto-increment +1

7.0    Demonstrations
The ZLS50110/1/4 Demonstration Software incorporates three ‘set-piece’ demonstrations which allow the user to
quickly and easily demonstrate some of the capabilities of the ZLE50110/1/4 Evaluation Board and the
ZLS0110/1/4 CESoP device. Many of the advanced options of the device are pre-configured for the demos to
reduce their complexity. Full control of the evaluation board and ZLS0110/1/4 is available using the Link
Establishment and Peripheral Link Establishment features. 

To create a new demo, press the ‘Demo’ button on the main toolbar or select the menu item File -> New ->
Demonstration.When the window appears, select the appropriate demonstration using the tabs at the top of the
window. Select the demonstration type using the ‘Demo Type’ drop down. Use ‘Lan to Lan Loopback’ for a one
board demo and ‘Lan to Remote’ for a two board demo. Then proceed to select the Agents from the drop down
selections as required in the dialogs. Once all agents have been selected, the rest of the dialog options can be
entered.

To run a demo, set the remaining parameters on the dialog and click on the Start/Stop button. The status box will
display the current state of the demo which can be ‘Idle’, ‘Starting’, ‘Running’, ‘Stopping’ or ‘Obtaining Report’.

7.1    The Audio Demonstration

The purpose of this demonstration is to set up an audio path between two handsets, with the audio data being
routed through the ZLS0110/1/4 device. The audio format is 128k PCM using two 64k timeslots. There are two
modes of operation for this demonstration:

7.1.1    LAN to LAN Loopback Mode

Audio data originating from handset 1 is sent out onto the LAN then looped back and received by the same device
which then decodes the packets and routes the data back to handset 2. A corresponding connection is established
in the opposite direction therefore a full-duplex conversation can be held between the two handsets on one
ZLE50110/1/4 Evaluation Board (See Figure 17).
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7.1.2    Local To Remote Mode

Two ZLE50110/1/4 evaluation boards are required for this demonstration, with two possible methods of control:

1. Both boards controlled using local management (using a local agents).

2. One board controlled using local management and the other controlled via by remote signalling using a manu-
ally registered proxy agent.

Audio data originating from handset 1 on the local evaluation board is sent over the LAN using the ZLS0110/1/4
device. This is received by the ZLS0110/1/4 on the remote evaluation board which decodes the packets and routes
the audio data to handset 1 on its evaluation board. A corresponding connection is established in the opposite
direction therefore a full-duplex conversation can be held between two evaluation boards (See diagram in Figure
18).

7.1.3    Audio Demonstration Configuration

Figure 17 - Audio Demo Configuration One Board
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The parameters available on this dialog are:

• Demo Type - Either ‘LAN to LAN Loopback’ or ‘Local To Remote’.
• Apply CET - Tick box selects CET timing recovery for this demonstration.

• Agent - Dropdown box allowing selection of the registered agent to run the demonstration on. In the case of 
Local to Remote mode, this agent will control the local device.

• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the evaluation board for the 
demonstration. If there is only one device on the evaluation board then this value will always be zero.

• TDM Stream - Which ZLS0110/1/4 TDM stream to use for the audio channels.
• MAC Port - Specifies which ZLS0110/1/4 MAC data ports to use to send/receive packets. The two ports 

selected must be connected by a crossed ethernet cable or a switch. For a one board demo select a different 
value on Tx and Rx.

• Low Byte Channel - For each of the four connections, this specifies the channel to use for the low channel 
of the 128k audio.

• High Byte Channel - For each of the four connections, this specifies the channel to use for the high channel 
of the 128K audio.

• Handset 1 CET - Button opens a CET configuration dialog to control CET timing recovery parameters. The 
CET parameters should be applied to the same TDM stream as selected for the demonstration.

• Status Window - This display shows the current state of the demonstration, state values are 
‘IDLE’,’STARTING’,’RUNNING’,’GETTING REPORT’ and ‘STOPPING’.

• Start/Stop Demo - Button starts or stops the demo.
• Handset 2 CET - Not used in one board demonstration, becomes ‘Remote Handset CET’ in two board 

demonstration.
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Figure 18 below shows the dialog for the two board version of the audio demonstration.

Figure 18 - Audio Demo Configuration Two Board

The additional items on this dialog are:

• Remote Agent - Dropdown box allowing selection of the registered agent to communicate with the remote 
device in the two board demonstration.

• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the remote evaluation board for the 
demonstration. If there is only one device on the evaluation board then this value will always be zero.

• Remote Handset CET - Button opens a CET configuration dialog to control CET timing recovery parameters 
for the remote ZLS0110/1/4 board in a two board demonstration. The CETparameters should be applied to 
the same TDM stream as selected for the demonstration. An agent for the remote board must be registered 
for this dialog to function.

7.2    The Channel Capacity Demonstration

The purpose of this demonstration is to allow the user to test the capabilities of the ZLS0110/1/4 device to cope with
various throughput loads, up to the maximum possible number of channels. This is done by allowing the user to
select how many streams they want and how many channels to use in each stream. When the demo is started, and
all the TDM channels have been linked by the ZLS0110/1/4(s), the MT90869 generates Bit Error Rate (BER) or
‘Fixed Pattern’ test data to prove the links. As the MT90869 can only run a single BER test at any one time, it is also
used to ‘zig-zag’ the data streams so that the test data passes through all of the used streams ( SeeFigure 19).
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The test data is periodically checked, with results being reported to the user. There are two modes of operation for
this demonstration, ‘LAN to LAN loopback’ and ‘Local to Remote’. Note that one ZLS0110/1/4 context is used per
stream.

Figure 19 - Channel Capacity Demo BER Datapath

7.2.1    LAN to LAN Loopback Mode

In this single board demo mode, the data packets for each stream are sent out onto the LAN, looped back and
received by the same stream on the same ZLS0110/1/4 device. This is used in conjunction with the MT90869 data
test path shown in Figure 19.

7.2.2    Local To Remote Mode

Two ZLE50110/1/4 evaluation boards are required for this demonstration, with two possible methods of control:

1. Both boards controlled using local management (using a local agents).

2. One board controlled using local management and the other controlled via by remote signalling using a manu-
ally registered proxy agent.

In this mode data packets for each stream are sent from a ZLS0110/1/4 device on the first evaluation board to a
ZLS0110/1/4 on the second evaluation board. The data on the second board is then looped straight back to the
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ZLS0110/1/4 on the same stream, re-packetised, and sent back to the first board. The test data is generated and
tested on the first board is using the MT90869 data test path sheme shown in Figure 19.

7.2.3    Channel Capacity Demo Configuration

Figure 20 - Channel Capacity Demo Dialog One Board

The items on the ‘Channel Capacity Demo Dialog’ shown in Figure 20 are:

• Demo Type - Either ‘LAN to LAN Loopback’ or ‘Local To Remote’.

• Apply CET - Tick box selects CET timing recovery for this demonstration.
• Agent - Dropdown box allowing selection of the registered agent to run the demonstration on. In the case of 

Local to Remote mode, this agent will control the local device.
• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the evaluation board for the 

demonstration. If there is only one device on the evaluation board then this value will always be zero.
• Transmit/Receive MAC Port - Specifies which ZLS0110/1/4 MAC data ports to use to send/receive packets. 

The two ports selected must be connected by a crossed ethernet cable or a hub. Select different values for 
transmit and receive in ‘Lan to Lan Loopback’ mode.

• Start Stream - The first ZLS0110/1/4 TDM stream to use for this demonstration.
• Number Of Streams - The number of successive streams to use.
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• Channels Per Stream - The number of channels to use per stream.
• Data Type - Bit Error Rate (pseudo-random data) or Message Mode (fixed pattern data).

• Report Poll Rate - How often to obtain a BER report in seconds.
• BER Lock (Read-Only) - Reports whether BER lock has been attained.

• BER Errors (Read-Only) - Numbers of errors detected.
• BER Resets (Read-Only) - Every time BER lock is not attained or BER errors are detected, the BER engine 

is reset and this number is incremented.
• Duration - Shows the length of time the demo has been running (Format hrs:mins:secs).

• Poll every - Sets the polling time in seconds for obtaining BER report. 
• CET Options- Button opens a CET configuration dialog to control CET timing recovery parameters. The 

CETparameters should be applied to the same stream as selected for the demonstration.
• Status Window - This display shows the current state of the demonstration, state values are 

‘IDLE’,’STARTING’,’RUNNING’,’GETTING REPORT’ and ‘STOPPING’.
• Start/Stop Demo - Button starts or stops the demo.

• CET Options (2) - Button opens a CET configuration dialog to control CET timing recovery parameters for 
the remote ZLS0110/1/4 board in a 2 board demonstration. The CETparameters should be applied to the 
same stream as selected for the demonstration. An Agent for the remote board must be registered for this 
dialog to function.

Note: Select the ‘Agent’ and ‘Demo Type’ first in order to activate the rest of the dialog fields.

Figure 21 below, shows the dialog for the two board version of the channel capacity demonstration.
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Figure 21 - Channel Capacity Demo Dialog Two Board

The additional items on this dialog are:

• Remote Agent - Dropdown box allowing selection of the registered agent to communicate with the remote 
device in the two board demonstration.

• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the remote evaluation board for the 
demonstration. If there is only one device on the evaluation board then this value will always be zero.

7.3    The Dynamic Channel Demonstration

The purpose of this demonstration is to allow the user to test the dynamic addition and removal of channels to/from
a ZLS0110/1/4 data link, with no interruption or loss of quality. This is done by establishing an audio data link
exactly the same as the Audio Demonstration, and adding channels with BER or ‘Fixed Pattern’ test data. Then the
user can add and remove additional channels at their leisure. While they do this, they can listen to the audio to
ensure the quality is not interrupted, and the regular BER reports will indicate any loss of data integrity. This
demonstration has two modes, ‘LAN to LAN loopback’ and ‘Local To Remote’, which are described in the next
section.
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7.3.1    LAN to LAN Loopback Mode

In this mode the data packets for the test stream are sent out onto the LAN, looped back and received by the same
ZLS0110/1/4 device. The audio traffic is routed from handset 1 to handset 2 in both directions and the BER test
data is generated and checked on the same MT90869 device (See diagram in Figure 22).

7.3.2    Local To Remote Mode

Two ZLE50110/1/4 evaluation boards are required for this demonstration, with two possible methods of control:

1. Both boards controlled using local management (using a local agents).

2. One board controlled using local management and the other controlled via by remote signalling using a manu-
ally registered proxy agent.

In this mode data packets for the test stream are sent from a ZLS0110/1/4 device on the first evaluation board to a
ZLS0110/1/4 on the second board. The audio traffic is routed from handset 1 on the first board to handset 1 on the
second board. The BER test data is generated by the MT90869 on the first board, looped back in the MT90869
device on the second board and the results checked back at the originating MT90869 (See diagram Figure 23).

7.3.3    Dynamic Channel Demo Configuration

Figure 22 - One Board Dynamic Channel Demo Dialog 
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The items on the top part of this dialog are:

• Demo Type - Either ‘LAN to LAN Loopback’ or ‘Local To Remote’.
• Apply CET - Tick box selects CET timing recovery for this demo.

• Agent - Dropdown box allows selection of the registered agent to run the demonstration on. In the case of 
Local to Remote mode, this agent will control the local device.

• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the evaluation board for the 
demonstration. If there is only one device on the evaluation board then this value will always be zero.

• TDM Stream - Which TDM stream to use for the audio channels.
• MAC Port - Specifies which ZLS0110/1/4 MAC data ports to use to send/receive packets. The two ports 

selected must be connected by a crossed ethernet cable or a hub.

Items on the ‘Audio Channels Tab’, are:

• Low Byte Channel - For each of the four connections, this specifies the channel to use for the first 8 bits of 
audio data (per sample).

• High Byte Channel - For each of the four connections, this specifies the channel to use for the second 8 bits 
of audio data (per sample).
Note. These items are the same as the items on the ‘Audio Demo Tab’ Figure 17.

Items on the ‘Data Channels’ Tab, shown in Figure 20, are:

• Start Test Channel - The first channel to use for BER/Message Mode data.

• Num Test Channels - The number of channels to use for BER/Message Mode data.
• Data Type - Either BER or Message Mode.

• Channels in use - Displays the current list of TDM channels in use. This helps with the selection of 
additional channels for the context modification part of the demonstration. Once the demo has been started 
the current channel list will show 0-3 which is the audio data, plus a list of channels which will match the 
‘Start Test Channels’ and ‘Num Test Channels’ settings.

• Additional Channels - Allows the user to specify the channels to add/remove to/from the link. The channels 
can be specified individually (delimited by commas) and/or in ranges using a hyphen, e.g 15,16 or 15-16.

• Add/Remove Channels - Button to add or remove channels. Note that after channels have been added, 
they must be removed before more channels can be added. If additional channels are specified when the 
demo is idle, they will automatically be added when the demo is started.

Items below the ‘Audio Channels’ and ‘Data Channels’ Tabs are:

• BER Lock (Read-Only) - Reports whether BER lock has been attained.
• BER Errors (Read-Only) - Reports the numbers of errors detected.

• BER Resets (Read-Only) - Every time BER lock is not attained or BER errors are detected, the BER engine 
is reset and this number is incremented.

• Poll every - Sets the polling time in seconds for obtaining BER report. 
• Handset 1 CET - Button opens a CET configuration dialog to control CET timing recovery parameters. The 

CETparameters should be applied to the same TDM stream as selected for the demonstration.
• Status Window - This display shows the current state of the demonstration, state values are 

‘IDLE’,’STARTING’,’RUNNING’,’GETTING REPORT’ and ‘STOPPING’.
• Start/Stop Demo - Button starts or stops the demo.
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• Handset 2 CET - Button opens a CET configuration dialog to control CET timing recovery parameters for the 
remote ZLS0110/1/4 board in a 2 board demonstration. The CETparameters should be applied to the same 
TDM stream as selected for the demonstration. An Agent for the remote board must be registered for this 
dialog to function.

Note. Select the ‘Agent’ and ‘Demo Type’ first in order to activate the rest of the dialog fields.

Figure 23 below, shows the two board version of the Dynamic Channel demonstration dialog.

Figure 23 - Two Board Dynamic Channel Demo Dialog

The additional items on this dialog are:

• Remote Agent - Dropdown box allowing selection of the registered agent to communicate with the remote 
device in the two board demonstration.

• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the remote evaluation board for the 
demonstration. If there is only one device on the evaluation board then this value will always be zero.

• Remote Handset CET - Button opens a CET configuration dialog to control CET timing recovery parameters 
for the remote ZLS0110/1/4 board in a 2 board demonstration. The CETparameters should be applied to the 
same TDM stream as selected for the demonstration. An Agent for the remote board must be registered for 
this dialog to function.
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7.4    Quick Start Demo Example

This section goes step by step through the set up of the single board audio demonstration.

1. Connect the Management Station network port to the network port on the CPU card using a crossed-over LAN-
cable.

2. Connect the MAC ports on the ZLE50110/1/4 board with a crossed-over LAN cable or switch.

3. Plug the two handsets into the ports marked Handset #1 and Handset #2.

4. Check the Link Settings for each board are in ST-BUS 8Mb/s mode as shown in Figure 24:

Figure 24 - Standard Demonstrations Jumper Settings

5. Start the Management Station Software

6. Start the Embedded Agent Software.

7. Wait for the embedded agent to auto-register with the management station. (A window should be created which 
is the ‘Agent Configuration Dialog’ for the newly registered agent.).

8. Initialize the peripheral devices using this ‘Agent Configuration Dialog’:

Peripherals Tab - Load profile file ‘stbus_slave_8mbit.ZLE50110/1/4 using the ‘Load Profile’ button.

Bottom of dialog - Initialize agent with the hardware settings using the ‘Initialize Agent’ button.

Wait a few seconds for the Message ‘All Devices Intialized’ to appear.

9. Open the Demo Dialog using the ‘DEMO’ button or File->New->Demo.

10.Select and configure the items in the ‘Audio Demo’ tab:

Demo Type is set to Lan to Lan Loopback (one board demo).

Agent is selected from the drop down list. (will be the auto-registered agent).

Apply CET is left unchecked.

ZLS0110/1/4 ID is zero.

Handset 1 TDM stream and Handset 2 stream are set to 0.

Handset 1 MAC Port is set to 0 and Handset 2 MAC port is set to 1 (Matches cable arrangement).

Audio channel allocations ( 128k audio using two 64k channels) :

Handset 1 to LAN - Low byte chan set to 0, Hi byte chan set to 1.

LAN to Handset 1 - Low byte chan set to 0, Hi byte chan set to 1.

Handset 2 to LAN - Low byte chan set to 2, Hi byte chan set to 3.

LAN to Handset 2 - Low byte chan set to 2, Hi byte chan set to 3.

11.Start Demo with ‘Start Demo’ at bottom of the ‘Audio Demo’ tab.

J71 J73 J74J45 J47 J75

. . . .
..
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8.0    Receive Packet Pattern Matching

8.1    Protocol Match Editor

This is an advanced feature which requires the user to have knowledge of the ZLS0110/1/4 receive packet classifier
(PKC). For more information see the ZLS0110/1/4 Programmers Model. This knowledge is not required to run any
of the ‘set piece ‘ demonstrations.

The ‘Protocol Match Editor’ is a tool allowing the user to set up protocol pattern matches in the ZLS0110/1/4 packet
receiver. Any incoming packet must have a protocol which fits one of 4 pre-programmed protocol templates
supported in the ZLS0110/1/4. In addition, selected bytes have to be passed to the ZLS0110/1/4 packet classifier
and post verifier to use for context packet routing and link verification. The complete protocol configurations, are
labeled as Protocol 0 to Protocol 3 in the configuration options.The protocol configuration stores all matching, mask
and byte selections. 

The different matching requirements are controlled in the “Matching Configuration” on page 37.

The matching fields are selected by the field name from a selection list relevant to the protocol being used. The
protocol matching system allows the user to enter the required matching values plus a bit mask to allow partial
matching. The editor also supports an ‘apply to range’ feature to allow configuration changes to applied to more
than one protocol match configuration. This feature can be used in conjunction with a data auto-increment facility
which allows data fields to be incremented automatically for each protocol match configuration.For more
information on these features see the descriptions of the protocol match editor tabs.

The Protocol Match Editor is invoked using File -> New -> Protocol Match Editor, this opens the main ‘Protocol
Match Editor’ dialog.

8.2    Protocol Match Editor Dialogs

The protocol match editor dialogs, in Figure 25, use a series of configuration tabs plus the items in this section,
which are common to all tabs.The basic procedure for setting pattern matching is:

1. Add protocols and select match values using the using the ‘Protocols’ configuration.

2. Add match fields and mask values for all the matching types using the ‘Matching’ configuration.

3. Use the configuration duplication and auto-increment features as required, using the combination of the ‘Apply 
to Range’ and ‘Auto Increment’ Tabs.
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Figure 25 - Protocol Match Editor Dialog

The items common to all tabs are:

• Agent - Drop down dialog to select agent in use.

• Protocol – Drop down dialog to select the protocol match number to configure. The ZLS0110/1/4 chip 
supports 4 protocol matches so the allowed values for this parameter is 0 -3. The information displayed in the 
tab dialogs applies to the protocol match selected in this drop down. The configuration for the selected protocol 
match can be saved in a file on the management station PC using File -> Save.

• PM In Use – Tick box specifies whether or not the selected protocol match is to be used.
• Device - Specifies the ID of the ZLS0110/1/4 device to use for the protocol match. If there is only one device 

on the evaluation board then this value will always be zero.

Three other buttons apply to all tabs:

• Save Protocols - Stores the protocol match data for the selected match number to non-volatile memory on 
the ZLE50110/1/4 board.

• Apply Changes - Stores the changes to the protocol match configuration to the RAM on the ZLE50110/1/4 
board.

• Discard Changes - Clears the changes to the protocol match configuration without storing.
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8.2.1    Protocols Configuration

The pattern match protocol tab, in Figure 26, allows the user to add and remove protocols from the selected
protocol match configuration. In addition, the user can add matching values for any of the fields in the highlighted
protocol. 

Example. In Figure 26, the IPV4 protocol is highlighted, so the dialog is allowing match values for IPV4 parameters
such as IP Version number and Header Length to be entered.

Figure 26 - Protocol Match Editor Protocols Tab

The user can build a layer of protocols and their match values with these controls:.

• Protocol List Box- Display dialog shows a list of protocols included in the selected protocol match.
• Protocol Type - Drop down dialog allows the user to select a protocol type.

• Add - Button adds a protocol to the protocol match list. When this button is clicked, a new row appears in the 
protocols list display. The ‘Protocol Type’ drop down is used to select the new protocol.

• Remove - Button removes a protocol highlighted in the ‘Protocol List Box’
• Move Up- Button moves a protocol highlighted in the ‘Protocol List Box’ up one in the stack.

• Move Down- Button moves a protocol highlighted in the ‘Protocol List Box’ down one in the stack.
• Match Value Dialogs - These protocol dependent dialogs allow the user to enter the match values for the 

protocol selected in the ‘Protocol Type’ drop down. The mask values are set up in “Matching Configuration” 
on page 37. Entry boxes which are greyed out, are fields which are automatically calculated and can not be 
changed by the user.
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8.2.2    Matching Configuration

The matching configuration dialog,shown in Figure 27,allows the user to set up the match fields and masks for the
protocols entered in “Protocols Configuration” on page 36. 

Several features are included to make configuration easier:

1. The user can enter parameter fields by name from a selection list, rather than having to work out byte position 
by calculation.

2. Any changes to one match configuration can be automatically copied to a range of matches using the ’Apply to 
Range’ tab.

Figure 27 - Protocol Match Editor Matching Tab

The actions of this dialog vary according to the ‘Match Type’ selection, the control items are:

• Match Type - The pattern matching system has several match type options in line with the capabilities of the 
ZLS0110/1/4 chip. The match type options are:

‘Protocol Matching’ - An initial protocol match of the receive packet into 1 of 4 protocol templates. Selection
made from the 64 bytes in the 96 bytes packet header. The user provides values and masks 

‘Classification Matching’ - This is a selection of 12 bytes to be passed to the ZLS0110/1/4 packet classifier in for
context matching. When a link is made, the values in these selected bytes are checked against values stored
for each context to determine packet routing. (To apply masks to the selected 12 bytes use the Link
Establishment ‘Classification’ Tab.)

‘Post Verification Matching’ - This is a selection of 11 bytes to be passed to the post verifier in the ZLS0110/1/4
packet receiver. The post verifier is intended to be used for checking link specific data fields which can be used
to provide a measure of security. Normally the RTP SSRC and the L2TP protocol Cookie. 
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‘Pseudo-wire’ - Allows the user to select the PW value fields for the CESoPSN Protocol. 

‘Sequence Number’ - Programs the ZLS0110/1/4 with the required sequence number protocol. The options are
‘Sequence Number (RTP)’ or ‘Sequence Number (CES over PSN). 

‘Timestamp’ - Programs the ZLS0110/1/4 with the required timestamp protocol. The options are:‘Timestamp
(RTP)

‘Length’ - Tells the ZLS0110/1/4 which protocol to use to find the receive packet length. The options are ‘Header
Length (IPV4)’, Total Length (IPV4) and ‘Length (UDP)’. 

• Relevant Fields - A list showing a complete set of fields for the protocols entered in “Protocols 
Configuration” on page 36. The name of the field is shown next to the applicable protocol.The user can 
select the fields from this list, to be included in the selected match. These selections are then reflected in the 
‘Selected Fields’ box.

• Selected Fields Box - A list showing the matching fields that have already been added using the ‘Add’ 
button.

• Add - Button adds the selected protocol field to the protocol match.
• Remove - Button removes the selected protocol field from the protocol match.

• Remove All - Button removes all the selected protocol fields from the protocol match.
• Num Bytes - Shows the number of bytes in the selected field.

• Remaining Bytes - Shows the number of bytes remaining for a particular match type allowing for the fields 
already selected. (Max number of bytes are: Protocol Match 64, Classifier Match 12 and Post Verification 
Matching 11.)

• Mask Range - Applies to ‘Protocol Matching’ and ‘Post Verification Matching’, shows the correct mask range 
that can be applied to the selected field.

E.g. a mask range of ‘0x00 to 0xFF’ implies an 8 bit mask.

• Mask - Applies to ‘Protocol Matching’ and ‘Post Verification Matching’.Entry dialog allows the user to enter a 
mask within the ‘Mask Range’. A zero in the mask bits selects the bit for including in the match.

• Bytes Range - Applies to ‘Classification Matching’. Shows the allowed range of bytes to select for the 
selected field.

• Bytes - Applies to ‘Classification Matching’. Allows the user to enter the bytes to be sent to the packet 
classifier.

The format is the standard windows number entry: 1,2,3 for list or 1- 3 for range.

• Update - Button applies changes made in the ‘Mask’ or ‘Bytes’ dialogs.
• Discard - Button applies changes made in the ‘Mask’ or ‘Bytes’ dialogs.
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8.2.3    Apply To Range Configuration

This apply to range dialog,shown in Figure 28,allows the user to automatically apply changes made in one protocol
match configuration to other matches. In addition, the user can enable the auto-increment features as described in
the ‘Auto Increment Configuration’.

Figure 28 - Protocol Match Editor Apply Range Tab

The items on this dialog are:

• Apply to current context only - This tick box is usually checked to keep protocol changes limited to the 
selected protocol match. If unchecked, the changes made in one protocol match are applied to the matches 
selected by the ‘Range’ dialog.

• Range - Selects the range of protocol matches to receive the changes.

Format: Range 1 - 3 means apply to ‘protocol1’,’protocol2’ and ‘protocol3’

• Auto-increment enabled - Tick box to enable the auto increment feature described in the ‘Auto Increment’ 
configuration.

• Relative Increment - Tick box to enable the relative increment feature described in the ‘Auto Increment’ 
configuration. This tick box has to be checked in addition to the ‘Auto-increment enabled’ tick box.

8.2.4    Auto Increment Configuration

The auto-increment dialog, shown in Figure 29,is used to set the increment value when using the auto-increment
features.The required protocol is selected from the ‘Protocol Type’ drop down and the dialog displays the protocol
fields for that protocol. The dialog looks the same as the ‘Protocols’ tab except that the data values are zeroed.
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There are two auto-increment modes which are selected in the ‘Apply to Range ‘configuration.’

Figure 29 - Protocol Match Editor Auto Increment Tab

Auto Increment - The user selects sets an increment value which is applied over the range of protocol matches
specified in the ‘Apply to Range ‘ configuration.

Consider an example using the IPV4 parameter Time to Live (TTL), where the following procedure is followed:

1. The TTL field is set to 0 for match ‘Protocol0’ in the ‘Protocols’ tab.(This gives the initial value).

2. The range 1-3 is applied and the auto-increment is enabled in the ‘Apply to Range’ tab.

3. The increment value for the TTL field is set to 1 in the ‘Auto Increment’ tab.

Remembering to apply changes as required, the resulting values are:

‘protocol0’ has Time to Live of 0 (base value = 0)

‘protocol1’ has Time to Live of 1.

‘protocol2’ has Time to Live of 2.

’protocol3’ has Time to Live of 3.

Relative Increment - The user sets an increment value (I Val), which is then applied to each protocol match
according to the position relative to the selected match.

A match 1 above the selected one, gets an increment of 1 x I Val. 

A match 3 above the selected one, gets an increment of 3 x I Val.
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A match 2 below the selected one, gets a decrement of 2 x I Val.

The increment is applied over the context range entered in the ‘Apply to Range’ tab.

Consider an example using the IPV4 parameter Time to Live (TTL), where the following procedure is followed:

1. The TTL field is set to 8 for match ‘Protocol2’ in the ‘Protocols’ tab.(This gives the initial value).

2. The range 0-3 is applied and the relative increment mode is enabled in the ‘Apply to Range’ tab.

3. The increment value for the TTL field is set to 2 in the ‘Auto Increment’ tab.

Remembering to apply changes as required, the resulting values are:

‘protocol0’ has Time to Live of 4 (base value - 4)

‘protocol1’ has Time to Live of 6 (base value -2)

‘protocol2’ has Time to Live of 8, (selected protocol match, base value = 8)

’protocol3’ has Time to Live of 10 (base value +2).

8.3    Default Protocol Match Configurations

Two of the four protocol match configurations are pre-programed in the ZLS50110/1/4 system. They are used by
the ‘set piece’ demonstrations. 

• Protocol Match ‘Protocol0’ - Is used for the standard demonstration links.
Selected Protocols are: ‘Ethernet2’, ‘IPV4’, ‘UserDatagram (UDP)’, and ‘Real Time Protocol (RTP)’

Protocol Match is on: ‘Ethertype (Ethernet2)’, ‘Version (IP4)’, ‘Next Protocol (IPV4)’...

Classification Match Bytes (fields to send for context matching) are: ‘Destination Address (Ethernet2)’,
‘Destination Address (IPv4)’ and ‘Dest Port (UDP)’.

Verification Match Bytes (fields sent to post verifier) are: ‘SSRC (RTP)’.

• ProtocolMatch ‘Protocol1’ - Is used for the remote signalling protocol links.
Selected Protocols are: ‘Ethernet2’, ‘IPV4’, and ‘UserDatagram (UDP)’.

Protocol Match is on:

Classification Match Bytes (fields to send for context matching) are:

‘Destination Address (Ethernet2)’, ‘Destination Address (IPv4)’ and ‘Dest Port (UDP)’.

Verification Match Bytes (fields sent to post verifier) are not used.

The protocol match can be selected during link establishment in the “Classification Configuration,” on page 52.

9.0    Context Database
The context database holds protocol routing data for all available link contexts in each ZLS0110/1/4 device. Routing
data is stored for all available protocols for each context. and is used as required. A separate database is held for
each ZLE50110/1/4 board in a system, these need to be set up to ensure that no resources, such as IP Addresses
and UDP ports clash. The aim is to ensure that each context link can be uniquely identified by the ZLS0110/1/4
packet receiver by differences in the link protocol. The context database stores information for Data, Control and
Host contexts.
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When a link connection is required, a context number is obtained for both ends of the link. The routing resources for
the required link protocols are extracted from the context databases for the ZLS0110/1/4 devices at both ends of
the link. The addressing information is combined and sent back to both ends of the link to provide full
source/destination information. (IE. the source address from one board becomes the destination address for the
other.) The combined protocol routing information is used to program the packet transmitter and the context match
block in the ZLS0110/1/4 chip. The protocol data for the context database is initialized in “Context Database
Configuration” on page 21. Full setup and control of the Context Database is achieved using the “Context Database
Editor” on page 42.

Note. In order to carry out context routing by protocol, the context routing data in the Context Database has to be
used in conjunction with the ‘classification match fields’ entered in the “Protocol Match Editor” on page 34.

9.1    Context Database Editor

The ‘Context Database Editor’ is a tool allowing the user to set up the context protocol routing information in the
Context Database.The editor provides a list of protocols and data entry dialogs for the routing fields for each
protocol. The editor also supports an ‘apply to range’ feature to allow configuration changes to applied to more than
one context configuration. This feature can be used in conjunction with a data auto-increment facility which allows
data fields to be filled in automatically for each context. For more information on these features see the descriptions
of the ‘Context Database Editor’ tabs.

The Context Database Editor is invoked using File -> New -> Context Database Editor, this opens the main
‘Context Database Editor’ dialog.

9.2    Context Database Editor Dialogs

The context database editor dialogs use a series of configuration tabs plus the common items in this section (Figure
30).The basic procedure for setting up a context protocol routing entry is:

1. Select the required context from the ‘Context Dropdown’

2. Enter protocol routing resources values for the selected context using the ‘Protocols’ tab.

3. Use the configuration duplication and auto-increment features as required, using the combination of the ‘Apply 
to Range’ and ‘Auto Increment ‘ tabs.
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Figure 30 - Context Database Editor Configuration

The items common to all tabs are:

• Agent - Drop down dialog to select agent in use.

• Context– Drop down dialog to select the required context to configure.The options are: ‘Context Database 
Entry 0 - 127’,‘Control Context Entry 0 - 127’,and ‘Host Context Entry 0 - 15’. The configuration for the 
selected context can be saved in a file on the management station PC using File -> Save.

• PD In Use – Tick box specifies whether or not the selected context protocol is to be used for routing 
resources.

• Match in Use - Tick box specifies whether or not the selected context protocol data is to be used for context 
matching in the ZLS0110/1/4.

• Device - Specifies the ID of the ZLS0110/1/4 device to use for the context configuration. If there is only one 
device on the evaluation board then this value will always be zero.

Three other buttons apply to all tabs:

• Save Protocols - Stores the context routing data for the selected context, to non-volatile memory on the 
ZLE50110/1/4 board.

• Apply Changes - Stores the changes to the context configuration in the management station.

• Discard Changes - Clears the changes to the context configuration without storing.
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9.2.1    Protocols Configuration

The protocol configurations, as shown in Figure 30,allows the user to enter protocol routing data for the selected
context. The protocol is selected from the ‘Protocol List Box’ and the routing data is entered in the dialogs provided.

The used dialog items are 

• Protocol List Box- Display dialog shows the full list of protocols available for each context. Click on a 
protocol to select it for configuration.

• Routing Data Dialogs - These protocol dependent dialogs allow the user to enter the routing data values for 
the protocol selected in the ‘Protocol list box’.

9.2.2    Apply To Range Configuration

The apply to range dialog,shown in Figure 31,allows the user to automatically apply changes made in one context
configuration to other contexts. In addition, the user can enable the auto-increment features as described in the
‘Auto Increment Configuration’. 

Figure 31 - Context Database Editor Apply to Range Tab

The items on this dialog are:

• Apply to current context only - This tick box is usually checked to keep context data changes limited to the 
selected context. If unchecked, the changes made in one context are applied to the contexts selected by the 
‘Range’ dialog.

• Range - Selects the range of contexts to receive the configuration changes.

Format: Range 1 - 3 means apply to ‘context1’,’context2’ and ‘context3’
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• Auto-increment enabled - Tick box to enable the auto increment feature described in the ‘Auto Increment’ 
configuration.

• Relative Increment - Tick box to enable the relative increment feature described in the ‘Auto Increment’ 
configuration. This tick box has to be checked in addition to the ‘Auto-increment enabled’ tick box.

Auto Increment Configuration

The auto-increment dialog, shown in Figure 32,is used to set the increment value when using the auto-increment
features.The required context is selected from the ‘Context’ drop down and the dialog displays the protocol routing
fields for that context. The dialog looks the same as the ‘Protocols’ tab except that the data values are zeroed. The
required increment value for any of the available protocol items can now be entered.

Figure 32 - Context Database Editor Auto Increment Tab

There are two auto-increment modes which are selected in the ‘Apply to Range‘ configuration.

Auto Increment - The user selects sets an increment value which is applied over the range of contexts specified in
the ‘Apply to Range ‘configuration.

Consider an example using the UDP parameter Source Port., where the following procedure is followed:

1. The Source port is set to 2000 for context ‘Context Database Entry 0’ in the ‘Protocols’ tab.(This gives the initial 
value).

2. The range 1-3 is applied and the auto-increment is enabled in the ‘Apply to Range’ tab.

3. The increment value for the Source Port field is set to 2 in the ‘Auto Increment’ tab.
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Remembering to apply changes as required, the resulting values are:

‘Context Database Entry 0’ has Source Port value of 2000 (base value = 0)

‘Context Database Entry 1’ has Source Port value of 2002 (base value + 2)

‘Context Database Entry 2’ has Source Port value of 2004 

‘Context Database Entry 3’ has Source Port value of 2006 

Relative Increment - The user sets an increment value (I Val), which is then applied to each context,according to
the position relative to the selected context.

A context 1 above the selected one, gets an increment of 1 x I Val. 

A context 3 above the selected one, gets an increment of 3 x I Val.

A context 2 below the selected one, gets a decrement of 2 x I Val.

The increment is applied over the context range entered in the ‘Apply to Range’ tab.

Consider an example using the UDP parameter Source Port., where the following procedure is followed:

1. The Source port is set to 2008 for context ‘Context Database Entry 2’ in the ‘Protocols’ tab.(This gives the initial 
value).

2. The range 0-3 is applied and the auto-increment is enabled in the ‘Apply to Range’ tab.

3. The increment value for the Source Port field is set to 2 in the ‘Auto Increment’ tab.

Remembering to apply changes as required, the resulting values are:

‘Context Database Entry 0’ has Source Port value of 2004 (base value - 4)

‘Context Database Entry 1’ has Source Port value of 2006 (base value -2)

‘Context Database Entry 2’ has Source Port value of 2008 (base value = 8)

‘Context Database Entry 3’ has Source Port value of 2010 (base value +2

10.0    Link Establishment
The link establishment facilities produce the packet link connections between ZLS0110/1/4 chips. These links are
used automatically during the ‘set piece’ demonstrations featured in “Demonstrations,” on page 22, or can be used
explicitly using the dialogs in these sections to produce custom connections. To use the packet links,with test data
or audio, peripheral links must be also be established ( See “Peripheral Link Establishment,” on page 55). 

The links are established by a data exchange (handshake) between the agents for the ZLS0110/1/4 chip at both
ends of the link. A full link which can pass data, consists of a LanTx context on one chip and a Lan Rx context on
the other. The data exchange is achieved using the proprietary ZLink protocol.

(Note - one chip can be used for both ends of the link.)
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10.1    Link Establishment Dialogs

The link establishment dialog has multiple tabs for link control plus the following items which are common to all
tabs:

• Link Status Window - This window shows the status of the selected link. If <new> is clicked in the window, 
then a new link definition is created in a new row. The new link is automatically numbered and the link 
number is reflected in the ‘Link ID’ box. When an existing link is selected in the window, the parameters 
displayed in link dialog relate to that link. 

• Link ID - Information box shows the number of the selected link.

• Link Type - Drop down selection for the required link type. Options are:
‘Data Link’ - Link between the LAN interface and the TDM interface, converting TDM data to packet data.

‘Control Link’ - Link between LAN interface and the host (CPU) port. Intended to be for a protocol control link
such as RTCP.

‘Host Link’ - Link between LAN interface and the host (CPU) port. Intended for general use such as remote
signalling.

Link Establishment Buttons:

• Swap Rx and Tx - Swaps device parameters for the Rx and Tx ends of the link (Including channels).

• Copy Link - Produces new link with the same settings as the selected link.
• Rx CET Options - Opens CET dialog to select clocking options for the LAN Rx end of the link.(see “Circuit 

Emulation Services,” on page 62).
• Get Link Resources - Triggers a poll of the agents at both ends of the link, which gets the 

source/destination addresses for the protocol in use. This is combined to provide both ends of the link with 
the full source/destination information. This must be done before the link is established. In addition, the polls, 
reserve a context inside the ZLS0110/1/4 chip for use at each end of the link.

• Reset Link - Resets all the link software states to idle.
• Remove All Links - Removes all links from the ‘Link Status Window’.

• Remove Link - Removes selected link from the ‘Link Status Window’.
• Tx CET Options - Opens CET dialog to select clocking options for the LAN Tx end of the link.(see “Circuit 

Emulation Services,” on page 62).
• Establish Link - Establishes link (enabled only after resources are retrieved)

• Clear Link - Clears a link, and takes the place of the ‘Establish link’ button once a link is connected.
• Apply - Applies changes and saves the configuration on the management station.

• Cancel - Cancels changes without saving.
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10.1.1    Devices Configuration

This dialog allows the user to select the ZLS0110/1/4 device parameters and the agent to use for each end of the
link.The dialog is split into two halves, one for the LAN Tx side of the link and other for the LAN Rx side.

The items on this dialog are:

• Enabled- Tick box to enable the Rx/Tx end of the link.

• Agent is a Proxy - Tick box to select a proxy agent (Device is controlled via remote signalling).
• Agent - Dropdown box allowing selection of the registered agent to use to establish the link. 

• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use on the evaluation board for the link. If 
there is only one device on the evaluation board then this value will always be zero.

• Port - Data port of the ZLS0110/1/4 to be used for the link.
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10.1.2    Channels and Contexts Configuration.

This dialog allows the user to add a list of channels to the selected link.The channels are specified in terms of
channels and stream. E.g. channel 1 in stream 3.

The items on this dialog are:

• Tx Context - A drop down selection for the Lan Tx context number to be used for the link.selection. Options: 
‘Next Free Context’ or a context number 0-127.

• Tx Stream - Required LAN Tx stream for the channels to be added to the link channel list.
• Tx Channels - Required channels to be added to the stream in the ‘Tx Stream’ box.

• Rx Context - A drop down selection for the Lan Rx context number to be used for the link.selection. Options: 
‘Next Free Context’, or a context number 0-127.

• Rx Stream - Required LAN Rx stream for the channels to be added to the link channel list.
• Rx Channels - Required channels to be added to the stream in the ‘Rx Stream’ box.

• Lock Underrun Byte - Tick box configures the ZLS0110/1/4 chip to transmit a fixed character known as the 
‘Underrun Byte’ on the WAN Tx port, if there is a packet underrun on the LAN Rx port. If not checked,the last 
data byte repeated continuously during the underrun.
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• Underrun Byte - Byte to be transmitted on the WAN port during a LAN Rx packet underrun. (If the ‘Lock 
Underrun’ byte mode is selected)

• Add Channels - Add the channels and steam values from entry boxes to the link channel list.
• Remove Selected Channels - Remove the highlighted channels and streams from the link channel list.

• Remove All Channels - Remove the all channels and streams from the link channel list.
• Channel List - Shows the entered values for the all the link parameters in the dialog. The parameters must 

show in this list for the link to work.
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10.1.3    Protocol Selection Configuration

The protocol selection dialog, shown in Figure 33,allows the user to configure the network protocol to be applied by
the ZLS0110/1/4 to the selected link. The protocols are chosen in sequence from the ‘Available Protocol’ list and
added with the ‘ADD’ button. 

The protocol layers should be added in the correct order as in the example in Figure 33. E.g. Ethernet2,
IPV4,UDP,RTP. Short cut buttons at the bottom of the dialog, can add common protocol stacks in one button click. 

.

Figure 33 - Link Establishment Protocol Selection Configuration

The items in this dialog are:

• Available Protocols List - Protocols to be sent by the ZLS0110/1/4 are selected from this list and added to 
the ‘Selected Protocols’ list with the ‘Add’ button. The protocols should be selected in the correct stack order.
E.g. Ethernet2, IPV4, UDP etc.... 

• Selected Protocols List - The list of protocols added with the ‘Add’ button.

• Add - Button to add the protocol selected from the ‘Available Protocols’ list to the ‘Selected Protocols List.
• Remove - Button to remove a highlighted protocol from the ‘Selected Protocols list’.

• Move Up- Button moves the highlighted protocol up one position in the ‘Selected Protocols list’.
• Move Down - Button moves the highlighted protocol down one position in the ‘Selected Protocols list’.

• Shortcuts - A series of buttons which add common protocol combinations as shown on the button test.
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10.1.4    Classification Configuration

This configuration dialog,shown in Figure 34, allows the user to select the required pattern match for the link. In
addition masks can be applied to the 12 byte context matching data selected in the ‘Classification Match’. (See
“Matching Configuration,” on page 37). 

Figure 34 - Link Establishment Classification Tab

The items in the Classification Tab are:

• Pattern Match - Drop down dialog selects the pattern match to use for the link (allowed values 0-3).
• Available Fields - Displays a list of fields that are available for context routing in this pattern match. The 

information for each field includes the name, protocol and mask.
• Get Fields - Button refreshes the 

• Clear Fields - Button clears the masks for the fields.
• Field Mask Range - Shows the allowable mask range for the field highlighted in the ‘Available Fields’ dialog.

• Field Mask- Allows the user to enter a mask to refine the context matching. A bit value of ‘1’ in the mask 
removes the bit from the match.

• Update - Button applies the mask changes to the link.
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10.1.5    Advanced Configuration

This advanced dialog, shown in Figure 35, allows the user to configure parameters specific to the ZLS0110/1/4 link
packet handling. Two parameters of particular note are the ‘Apply CET’ tick box and the ‘Length Field select’. 

Figure 35 - Link Establishment Advanced Tab

• Frames Per Packet - Number of frames of TDM data to be included in the transmitted packet.
• Protocol Use Source - Tick box selects whether to use the Source or Destination field values when 

combining protocol resources.
• Length Field Select - A drop down selection to determine where the packet receiver looks for the packet 

length parameter. Options: ‘Ethernet2’, ‘IPv4 Protocol’, ‘IPv6Protocol’and ‘UDP’. Default: ‘IPv4Protocol’
• Apply CET- Tick box applies CET timing to this link. Use the ‘Rx CET’ or ‘Tx CET’ buttons to set the CET 

parameters.
• Queue Size - Drop down options selects the queue size to be used for the packet receiver.

Options: (Range 2 - 1024 in powers of two.)

• Queue Mode - Drop down options to select the queue method to be used for the packet receive buffer.
Options: ‘FIFO’ - no packet resequnecing, ‘Resequence 8’ - resequencing on 8 bit packet numbers and
‘Requence 16’ - resequencing on 16 bit packet numbers.

• Jitter Buffer Size (Us) - Jitter buffer size in microseconds to be used in the packer receiver (Default 8000).
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• Queue Avg Mode - The queue average mode allows CET timing data in each packet to be hardware 
averaged before being processed by the software CET algorithms. This parameter sets the number of 
packets to be averaged. (Range 2 - 65536 in powers of 2 ).

• Queue Number - The required packet Tx queue number. Range 0 - 3.

• Ethernet Src Addr from MAC - This tick box, when checked tells the ZLS0110/1/4 to use it’s own MAC 
address for the outgoing packet. If not checked the outgoing MAC address is the one defined in the protocol 
header.

• Layer 5 Timestamp Increment - The count increment to be used in the layer 5 (E.g. RTP) timestamp).

• Layer 5 Timestamp From WAN - This tick box when checked, tells the ZLS0110/1/4 to use time stamp 
values based on WAN frames.f

10.1.6    Link Protocol Tab

This Tab has a display dialog which shows protocols in use during a link. The display becomes active when the ‘Get
Link Resources’ button has been clicked.

10.2    Example Data Link

This section shows an example of a uni-directional 2 channel ZLS0110/1/4 data link, which sends data on TDM
channels 0,1 and receives the data back on channels 2,3 (when used with one board and a loopback on the LAN
port ). To keep the example simple the protocol to be used in the link is Ethernet2/IPv4/UDP/RTP.

The following is assumed before we start the link:

• We have a single board with a local auto-registered agent.
• The board jumpers have been set for the ST-BUS Slave 8Mb/s mode.

• The peripheral profile ‘stbus_slave_8mbit.ZLE50110/1/4’ has been loaded and the agent initialized.

If more information is required on this initialization see “Quick Start Demo Example” on page 33.

The steps for establishing a link are:

1. Open the Link Establishment dialog using the ‘LINK’ button or File->New->Link.

2. Click on <New> at top of link dialog. A new link will be created and Link ID will show as 1 for the new link.

3. Link Type is set to ‘Data Link’.

4. Select and configure the items in the ‘Devices’ tab:

Agent is selected for TX and RX from the drop down list. (will be the auto-registered agent).

Enable is checked for TX and RX.

ZLS0110/1/4 ID is zero.

Port is set to 0 for TX and 1 for RX (Required for a looped data path with one board).

5. Add the required channels and streams using the ‘Channels and Contexts ’ tab:

Tx Context and Rx Context are set to ‘Next Free Context’.

Tx Stream and Rx Stream are set to 0.

Tx Channels are set to 1,2 and Rx Channels are set to 2,3.

Channels are added to the ‘Channel List’ using the ‘Add Channels’ button.

Lock underrun byte is set to 85 ( value not important for this link).
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Lock underrun Byte is checked.

The channels and stream information should now show in the ‘Channel List’ dialog.

6. Set the transmitted protocol stack to Ethernet2/IPv4/UDP/RTP. using the ‘Protocol Selection’ tab:

The required protocols are added using the Shortcut button ‘IPv4/UDP/RTP’. 

(This is an alternative to selecting each protocol using the ‘Available Protocols’ list and the ‘Add’ button.)

7. Select the pre-configured pattern match using the ‘Classification’ tab:

Pattern Match is set to 0 ( Protocol match 0 matches on Ethernet2/IPv4/UDP/RTP).

Clear any masks with ‘Clear Fields’ button.

8. Select and configure the items in the ‘Advanced’ tab:

Length Field Select is set to ‘IPv4 Protocol’.

Apply CET is unchecked.

The other items are left as default:

Frames per Packet is set to 1.

Queue Size is set to 128.

Queue Mode is set to ‘FIFO’.

Jitter Buffer Size is set to 8000.

Queue Avg Mode is set to 512.

Queue Number is set to 0.

Ethernet Src Addr From MAC is checked.

Layer 5 Timestamp Increment is set to 256.

Layer 5 Timestamp From WAN is unchecked.

9. Click on the ‘Get Link Resources’ button to reserve contexts and get information from both agents to make the 
link.

10.Click on ‘Establish Link’ to activate link. The link state should now show as ‘established’ in the link display at the 
top of the link establishment dialog.

Note. The link created in this example is a ZLS0110/1/4 link, converting TDM -> Packet -> TDM (assuming a LAN
loopback). In order to use this data for an audio link or data test, peripheral links have to be created.

11.0    Peripheral Link Establishment
The peripheral link features are required to connect data to and from the peripheral devices on the ZLE50110/1/4
board. These peripheral devices are used to provide test data for the ZLS0110/1/4 chip, and provide interfaces to
the outside world, such as audio code interfaces or a line interface cards. The ZLE50110/1/4 board can
accommodate a series of plug-in modules containing peripheral devices. These modules are selected using a slot
parameter, with slot 0 representing the built- in devices on the motherboard. 
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The built in devices and their basic uses are shown below:

MT90869 Switch Chip - Provides data routing, Bit Error Rate (BER) test data, and fixed pattern test data for the
ZLS0110/1/4 links and demonstrations.

The MT90869 chip is connected to two TDM busses known as the ‘LOCAL’ and ‘BACKPLANE’. The MT92303
Codec is attached to stream 0 of the ‘BACKPLANE’ bus and the ZLS0110/1/4 chip, is on the ‘LOCAL’ bus. A key
part of the data path setup is to set the correct path through the MT90869.

A path of ‘BACKPLANE’ to ‘BACKPLANE’ gives a loop on the Codec side of the MT90869.

A path of ‘BACKPLANE’ to ‘LOCAL’ gives a path between the Codec and the ZLS0110/1/4.

A path of ‘LOCAL’ to ‘LOCAL’ gives a loop back on the ZLS0110/1/4 TDM streams. This is used at the remote end
of a BER test path involving two boards.

MT92303 Codec - Provides an audio capability via twin handsets. (See “The Audio Demonstration,” on page 22).

The T1/E1 plug in card includes these two devices:

Cirrus S61884 LIU - Provides a line interface giving a serial TDM link, which allows use of an external tester/data
source. Can be set to E1 data stream at 2Mb/s or T1 at 1.544Mb/s.

MT9072 Framer - Primarily provides the ZLE50110/1/4 board with up to 8 BER data streams to test the
ZLS0110/1/4 chip.

The data paths, streams and channels are all set in the “Peripheral Link Dialog,” on page 56, which provide different
options depending on device type. If the connection is local the dialog selections only show devices

11.1    Peripheral Link Dialog

This dialog is used to set a peripheral link for an individual device on the ZLE50110/1/4 board. The dialog is opened
using the peripheral link button the main tool bar, or using Files->New->Peripheral Link. The peripheral link
establishment dialog has multiple tabs for link control plus the following items which are common to all tabs:

• Peripheral Link Status Window - This window shows the status of the selected peripheral link. If <new> is 
clicked in the window, then a new link definition is created in a new row. The new link is automatically 
numbered and the link number is reflected in the status window. When an existing link is selected in the 
window, the parameters displayed in the dialogs relate to that link.

Peripheral LInk control buttons:

• Remove All Links - Removes all peripheral links from the ‘Peripheral Link Status Window’.

• Remove Link - Removes selected peripheral link from the ‘Peripheral Link Status Window’.
• Copy Link - Produces new peripheral link with the same settings as the selected link.

• Establish Link - Establish selected peripheral link. 
• Clear Link - Clears the selected peripheral link, and takes the place of the ‘Establish link’ button once a link 

is connected.
• Discard - Discards changes without applying them.

• Apply - Applies changes to the peripheral link configuration.
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11.1.1    Device Configuration

This dialog is used to select the required device from the available slots, cards and chips. When a local peripheral
link is selected in the ‘Agent ‘ tab, the drop down options only show detected cards/devices and the correct
selection of options relevant to that card and device. If a remote peripheral link is selected, the full list of options is
shown in the drop down dialogs.

The items on this dialog are:

• Agent - Drop down dialog to select an agent to use. Can be a local or remote.
• Card - A dropdown selection for the available cards fitted the ZLE50110/1/4 board. The selections show the 

card type and the slot used by the card. Slot 0 refers to the motherboard devices and slot 1 to 4 refer to slots 
available for the plug-in cards.

Example selections are: -.

‘card_869 (slot 0) ‘- referring to the peripheral devices on the motherbord.

‘card-t1e1 (slot 1)’ - referring to the plug-in T1/E1 card which includes a S61884 LIU and a MT9072 Framer
chip. (fitted in slot 1).

‘card_t3e3 (slot 3) ‘ - referring to the plug-in T3/E3 card (fitted in slot 3).
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• Card Option- A drop down selection of the card options available for the card type. Only defined for two 
card types: The card 869 options are: ‘OFF’ and ‘869’. The user should select ‘869’, which gives access to 
the motherboard devices: MT90869 switch and MT92303 Codec.
The options for the E1/T1 card are:

‘OFF’ 

‘T1 Framer LIU’ - Data path is ZLS0110/1/4 -> MT9072 -> LIU.

‘T1 LIU’ - Data path is ZLS0110/1/4 -> LIU.

‘T1 R9072’ - The MT9072 is in reverse framer mode, where BER from the MT9072 data is sent to ZLS0110/1/4
chip and not the LIU card.

‘E1 Framer LIU’ - Data path is ZLS0110/1/4->MT9072->LIU.

‘E1 LIU’ - Data path is ZLS0110/1/4 -> LIU.

‘E1 R9072’ - The MT9072 is in reverse framer mode, where BER from the MT9072 data is sent to ZLS0110/1/4
chip and not the LIU card.

• Device - A drop down selection of possible devices to be used in the chosen card. The devices options in 
the ZLS50110/1/4 demo system are ‘MT90869’, ‘MT9072’, ‘MT92303’ and the ‘CS61884’ as discussed in 
‘“Peripheral Link Establishment,” on page 55. The device options are suffixed by the device number to 
distinguish between multiple devices of the same type. E.g. ‘MT90869 0’, ‘MT90869 1’ etc.
Other devices may show on the device selection list, but they are not used in support of the ZLS0110/1/4 links.

• Data Type - Selects the data type option to configured in to the peripheral device.The options are ‘TDM’, ‘ Bit 
Error Rate Pattern ‘ , ‘Fixed Pattern’ and ‘Audio’. The audio selection is only used with the MT92303 codec 
chip.

• Direction - A drop down selection for the data path to configured into the peripheral device. The data paths 
are uni-directional and are device dependent: 

The MT90869 Switch options are: 

‘Default’ - No data path between ‘BACKPLANE’ and ‘LOCAL’ bus. (Can be used with 

‘LOCAL to LOCAL’ - loops data on ZLS0110/1/4 side of switch.

‘LOCAL to BACKPLANE’ - routes data from the ZLS0110/1/4 side, to the codec side of the switch.

‘BACKPLANE to LOCAL’ - routes data from codec side, to the ZLS0110/1/4 side of the switch.

‘BACKPLANE to BACKPLANE’ - loop data on codec side of switch.

The MT9072 Framer options are:

‘Default’ - Straight through data path from the LIU side to ST-bus side of the MT9072. In reverse framer mode
the data that would normally go to the LIU card is sent to the ZLS0110/1/4 WAN interface.

‘Digital Loopback’ - Data loop on the ST-BUS side of the MT9072.

‘Payload Loopback’ - Data loop on the LIU side of the MT9072.

The cs61884 LIU options are:

‘Default’ - Straight through datapath.

‘Digital Loopback’ - Data loop on the framer side of the cs61884.

‘Remote Loopback’ - Data loop on the line side of the cs61884.
58
Zarlink Semiconductor Inc.



ZLS50110/1/4 Demonstration Software User Guide
11.1.2    Channels Configuration

The channels configuration, shown in Figure 36,allows the user to enter the channels and stream to connect in and
out of the chosen device. This configuration tab only shows when specific devices are selected and the ‘Data Type’
is set to ‘TDM data’ or ‘Fixed Pattern’.

Figure 36 - Peripheral Link Channels Configuration 

The items on the channels configuration are:

• Src Stream - Enters the required source stream for the channels to be added to the peripheral link. 
• Src Channels - Enters the required source channels to be included in the peripheral link for the selected 

stream. 
• Dest Stream - Enters the required destination stream for the channels to be added to the peripheral link. 

• Dest Channels - Enters the required destination channels to be included in the peripheral link for the 
selected stream. 

• Add - This button adds the channels and steam values from entry boxes to the peripheral link channel list.
• Channel List - Shows the entered stream and channel values for the peripheral link entered with the ‘Add’ 

button. The channels must show in this list for the link to work.
• Remove Selected Channels - This button removes the selected streams and channels highlighted 

channels and streams from the peripheral link channel list.
• Remove All Channels - This button removes the all source and destination channels and streams from the 

peripheral link channel list.
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11.1.3    BER Channels Configuration

The BER channels configuration, shown in Figure 37, is only available when a device is selected which has an
internal Bit Error Rate (BER) test pattern generator and the ‘Data Type’ is set to ‘Bit Error Rate’. It allows the user to
configure the BER test set up. 

Figure 37 - Peripheral Link BER Channels Configuration

The dialog items are:

• Generating Stream - Enters the stream to be used for source of the BER test data.

• Start Channel - Enters the first channel of BER data on the generating stream.
• Checking Stream - Enters the stream to be used for receiving and testing the BER test data.

• Start Channel - Enters the first channel of data to be checked on the checking stream.
• Num Channels - Enters the number channels to be included in the BER testing. This is applies to both the 

generating and checking stream.
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11.1.4    Polling & Results Configuration

The polling and results dialog shown in Figure 38, is only available when a device is selected which can generate
test data. (‘Bit Error Rate’ or ‘Fixed Pattern’). This dialog starts and stops the BER test and shows the results.

Figure 38 - Peripheral Link Polling & Results Configuration

The polling and results dialog has the following items:

• Poll every - Enters the result polling time in seconds for the BER test. After this time a poll is sent from the 
management station to the embedded agent, which returns the BER result. The results are displayed in the 
result boxes. 

The result boxes have the following items:

• BER Lock - Shows a test pattern lock status ‘TRUE’ or ‘FALSE’.
• Errors - Show the count of the bit error detected during the test.

• Resets - Shows the number of times the BER generator has been reset. The BER is reset during each burst 
of errors.

• Test Duration - Shows the length of time the BER test has been running in a format: hours: minutes. 
seconds.

• Event Log - Shows a time and error count when errors are detected or BER lock is lost.
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11.2    Peripheral Link Example - Audio Loopback

This section shows a simple example of an audio loop set up with two peripheral links. The MT92303 codec is set
up as an audio source with it’s two handsets, and the MT90869 switch is set up to provide a loop back on the ‘Back
Plane’ bus. The audio is 128k PCM using two 64k TDM channels. 

P-Link 1 - Codec Audio

Device Tab:

Card is set to ‘card_869 ‘.

Card Option is set to ‘869’.

Device is set to ‘MT92303’.

Data Type is set to ‘Audio’.

Direction is set to ‘Default’.

P-Link 2 - MT 90869 Back-plane bus Data Loop

Device Tab:

Card is set to ‘card_869 ‘.

Card Option is set to ‘869’.

Device is set to ‘MT90869’.

Data Type is set to ‘TDM’.

Direction is set to ‘BACKPLANE to BACKPLANE’.

Set up audio loop on stream 0.

Channels Tab:

Src Stream, Dest Stream are set to ‘0’.

Src Channels are set to’0 - 3’.

Dest Channels are set to 2,3,0,1 

12.0    Circuit Emulation Services

12.1    Introduction

The Circuit Emulation Timing (CET) services provide clock synchronisation between boards using packets sent
between them. There are two modes of operation:

1. Adaptive - Timing information related to a Tx stream clock on one ZLS0110/1/4 chip, is transmitted in packets 
by that ZLS0110/1/4 to another chip on another board.The ZLS0110/1/4 chip on the receiving board, detects 
these packets and uses the timing information to adjust the DCO frequency on the receiving stream to match the 
sending clock. In the adaptive scheme, the timing information is sent in the RTP or Pseudo-wire header of a 
data context. This is known as ‘in-band’ clock recovery.

2. Differential - The same reference clock is supplied to the ZLS0110/1/4 chips on the boards at both sides of a 
link. Timing information describing the difference between the stream clock and the reference clock on the local 
board is sent in ZLS0110/1/4 packets to the remote board. The receiving ZLS0110/1/4 chip on the remote board 
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adjusts it’s DCO to give the same difference with the reference clock. In this differential mode, timing information 
can be sent in the RTP header of a standard data context (In-band clock recovery), or can be sent in a separate 
timing packet. (Out of Band clock recovery). 

12.2    CET Dialog

In the Demonstration and Link Establishment dialogs, the CET options button can be used to invoke the CET
dialog. This is used to set up the required CET parameters and it has the following items:.

• Agent - Dropdown box allowing selection of the registered agent to run the CET.
• ZLS0110/1/4 ID - Specifies the ID of the ZLS0110/1/4 device to use for the CET. If there is only one device 

on the evaluation board then this value will always be zero.
• Stream - Drop down specifies the ZLS0110/1/4 TDM stream to use with CET.

• Mode - Drop down dialog to select the CET mode. Allowed values are ‘Slave’ and ‘Off’.
• Parameter List - A list of parameters that can be used with the CET features. The parameters are selected 

in this list and the value entered in the ‘Parameter Value’ dialog.
The user parameters needed to control the CET algorithm are:

cetRecoveryMode - Cet algorithm mode available options:

‘disable ‘ - No CET.

‘diff_rx’ - Differential out of band timing mode, packet receive end.

’diff_tx ‘ - Differential out of band timing mode, packet sending end.

‘diff_inband’ - In band differential mode.

‘adaptive’ - Adaptive CET mode (inband).

cetNetType - Network type, allowed options ‘dedicated’, ‘metropolitan ‘, ‘continental’ (Controls filter settings).

The user parameters for the Demo system support the CET algorithm:

cet_resultPollEnable - Enables data collection feature for CET graphs (Options: 0 disables, 1 enabled).

cet_resultPollTime - Enters the time in seconds.

Other parameters:

cetFramesPerPacket - Number of CET frames per packet.

cetPpmLimit - Sets the maximum deviation from the nominal frequency (Depends on DCO range).

cetRtpIncrementMode - RTP timestamp units for adaptive recovery. Allowed options ‘bit’,’frame’,’8 bytes’,
‘byte’. 

cetInBandDifRemoteFreqHz - Frequency of the remote primary reference source for differential inband mode.

cetDiffTxIpDest - Destination IP address for the out of band differential mode Tx packets.

cetDiffPortNum - Destination port number for out of band differential mode.

cetDiffRemoteStreamNum - Remote stream number for differential mode.
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cetDiffPacketRate - Rate at which differential timing packets are sent. ( 1 is every interrupt, 2 every second
inrerrupt etc.)

cetIgnoreLatePackets - Excludes late packets from the clock recovery calculations. Options ‘enable’,’disable’.

• Parameter Value - Enters the value for the parameter selected of the ‘Parameter List’.
• Refresh - Button refreshes the parameter values in the ‘Parameter List’.

• Discard Changes - Button discards changes without saving.
• Apply Changes - Button saves the configuration changes.

12.3    System Setup For CET Modes

Some modes of CET operation, require the use of wire straps to provide clocks to particular headers.The modes
are summarised below:

12.3.1    Adaptive CET with Unstructured TDM Streams

Each stream is clocked independently no hardware straps required.

12.3.2    Adaptive CET with Structured TDM Streams

The board on the CET slave end has to be synchronised to the adapted clock. This is done by linking the output
clock from one of the streams to the Jumper J25. Figure 39 shows the clock from stream 0 being used.

Figure 39 - Wire Link For Adaptive Unstructured CET Mode

12.3.3    Differential CET

In differential CET mode the same clock is applied externally to both boards. It replaces TCXO/VCXO as normally
selected by J20. J20 is removed and the clock applied to the centre pin (Figure 40).

Figure 40 - Clock Links for Differential CET
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12.4    Example Settings for Adaptive CET

Figure 41 - Example Settings for Adaptive CET
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12.5    Example Settings for Differential CET

Figure 42 - Example Settings for Differential CET

13.0    Graph Display System
The graph display system provides a flexible graph display system consisting of two parts:

1. A data capture buffer system on the ZLE50110/1/4 Board.

2. A data polling and graph display on the PC management station.

The graph system is controlled by the ‘Graph Control Dialog’ which can be invoked using the ‘Graph Button’ on the
main toolbar or by using File->New-> Graph. Once the data capture and display has been configured, the graph
view can be triggered to see the resulting graph.

13.1    Graph Control Dialog

The graph control dialog shown in Figure 43, allows the user to set the parameters needed to capture WAN TX
clock frequency data to specified set of buffers and display the resulting data samples in a graph. This is aimed at
illustrating the behaviour of the CET adaption algorithms.
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Figure 43 - Graph Control Dialog

The items on the graph control dialog are:

• Sample Lists - Provides a list of sample streams for the graph, each stream can become a line on the 
graph. Up to 10 lines can be activated for each graph. The sample list also shows the ‘State’, ‘Colour’ and 
‘Visibility’ setting for each line. (See the individual dialogs for more details). When a line is selected in the 
sample list,the information for that line is shown in the rest of the dialogs.

• ID - Shows the ID of the currently selected graph line (0 - 10).

• Colour - The colour of the selected graph line. Allowed selections are 
‘Black’,’Blue’,’Green’,’Cyan’,’Red’,’Magenta’,’Yellow’ and ‘Grey’.

• Poll Frequency - Enters the polling frequency that the PC management station uses to get graph data from 
the ZLE50110/1/4 board.

• Samples per Poll - The number of data samples to be recovered by each poll.
• State - Shows the current state for the selected graph line. Displayed values are ‘Capture’ for capture in 

progress and ‘Idle’ for inactive.
• Agent - Drop down dialog selects the agent to be used for graph polling.

• Buffer - Drop down dialog selects the data capture buffer to be used for the selected graph line. The 
selections are ‘Device 0,WAN TX stream n frequency’ for n= 0 to 31. The option names have been chosen 
because the main use of the graph display is to show the frequency data at the WAN Tx side of a CET timing 
session.

• Visible - Tick box determines whether the graph line is shown or not.
• Max Samples - Enters the maximum number of data samples to be stored in the data capture buffers before 

overwrite occurs.
• Seq Num Spacing - This parameter is set to match the number of samples per second produced by the 

ZLE50110/1/4 board. This should be set to 1.
• Clear Sample List - Button clears the sample data for the selected graph line.
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• Start Capture - Button starts the data capture for any line selected in the ‘Sample List’ on the selected 
ZLE50110/1/4 board.

• Stop Capture - Button stops the data capture for any line selected in the ‘Sample List’ on the selected 
ZLE50110/1/4 board.

• Apply Changes - Button sends configuration changes to the ZLE50110/1/4 board.
• Discard Changes - Button discards configuration changes without saving.

• Clear All Sample Lists - Button clears all of the sample data.
• New Graph View - Button opens a ‘Graph View Dialog’ as in next section.

• Export As Ascii - save graph data as an Ascii text file.

13.2    Graph View Dialog

The graph view dialog can be used to format the graph display while the data capture and graph generation is
running. In the ZLS50110/1/4 demo software, the X axis represents time in seconds and the Y axis represents the
frequency code written to the DCO. 

The graph view configuration items are:

• Freeze - Stops the update of the graph output. When in freeze mode the user can zoom in on a section of 
graph by dragging a box with the left mouse button. The user can zoom out by right clicking the zoomed 
image.
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• Resize to Fit - Changes the graph scale so that the whole graph (all the samples) fits into the output 
window. As time goes by the graph will become more compressed on the x axis.

• Scroll X Axis - Selects the X Axis scroll mode where the graph moves with time to the left with new samples 
replacing old. The scale of the graph is selected by the ‘Scroll Window Size X Axis’ parameter.

• Scroll YAxis - Selects the Y Axis scroll mode, where the graph moves downwards if the Y Axis data value is 
too great fit the display window. The scale of the graph is selected by the ‘Scroll Window Size YAxis’ 
parameter.

• Scroll Window Size X Axis - Sets the number of graph points to fit into the horizontal axis of the graph 
display window, in ‘Scroll X Axis’ mode.

• Scroll Window Size Y Axis - Sets the number of graph points to fit into the vertical axis of the graph display 
window in ‘Scroll Y Axis’ mode.

• Grid Size X Axis - Selects the x axis grid spacing in terms of number of graph points between grid lines. A 
value of 1000 produces a grid with 1000 graph points between lines.

• Grid Size Y Axis - Selects the grid spacing in terms of the data values on the Y Axis. A value of 5 produces a 
grid line on every 5 Y Axis data units.

• Update Graph - Button forces an instant graph refresh with the latest samples. 

14.0    ZScripts
ZScripting is a feature where functions defined in a ‘look up’ mechanism in the embedded agent software can be
executed in a run-time script from the management station. The script allows all the parameters to be defined, and
will execute functions one-by-one in the order specified. Only functions that have been entered into the function
look-up table can be executed using scripts. Functions can be executed on multiple devices using a single script,
and results from one function can be stored and used as parameters to a subsequent function.

This section describes the syntax of ZScripts, how to use them and the utility functions that can be used. It also
describes the ZLS50110/1/4 Demonstration API and the ZLS50110/1/4 Call Control API, which can be executed
using ZScripts.

14.1    ZScript Syntax

A ZScript is made up of two sections; ‘DEVICES’ section and ‘SCRIPT’ section. The DEVICES section is where the
devices that are used by this script are defined. To define a device, the user must specify a unique device tag
(which is used to identify the device throughout the script), the ip-address of the device and the port to send packets
to. This is done in the following format:

device-name = ip-address:port

The SCRIPT section is where the list of function calls is specified. Each function call starts with a device tag
followed by a colon, then the function call. For example:

device1: ZLS0110/1/4DemoSystemInit(0);

In addition to function calls, integer values can be defined on the board in a similar fashion to a normal c program.
Therefore the previous example could be replaced by the following:

device1: #define DEVICENUM 0

device1: ZLS0110/1/4DemoSystemInit(DEVICENUM);
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Comments can be added to scripts (‘//’ format only). Function calls can be multi-line, but the device tag only needs
to be specified once for each function call. Here is an example of a complete script:

DEVICES

device1 = 134.199.77.110:161

device2 = 134.199.77.120:161

SCRIPT

// Define device numbers

device1: #define DEVICENUM 0

device2: #define DEVICENUM 1

// Initialize devices

device1: ZLS0110/1/4DemoSystemInit(DEVICENUM);

device2: ZLS0110/1/4DemoSystemInit(DEVICENUM);

If a device tag is used in the SCRIPT section but is not defined in the DEVICES section, the user is given the option
to run the script anyway, but ignore any function calls with the unrecognised device tag. When a script is run, each
line in the script section is only executed when the last line has finished. Results of scripts can be viewed using the
event log.

14.2    ZScript Registers

In order to be able to pass the results of one function as parameters to a subsequent function, the user must use
the ‘temporary registers’ on the device. Registers are used to store values while a script is running, and they can be
used in a similar fashion to normal variables in a c program. There are three types of registers that can be used:

‘a’ registers (aReg) – These store 32-bit integer values. 8 or 16-bit values can be stored, but a casting function
should be used in conjunction (see ‘ZScript Utility Functions’).

‘c’ registers (cReg) – These can be used to store string values.

‘v’ registers (vReg) – These can be used to store pointer values.

There are 10 registers of each type. An example of using an aReg is shown below, where the result of one addition
function is used in another addition:

SCRIPT

device1: aReg1 = aPlusB(10, 20);

device1: aReg2 = aPlusB(aReg1, 20);

The address-of character ‘&’ can be also be used when results are returned via parameters, just like in standard c
programs. This is illustrated in the following example where the aPlusB function returns its result in a third
parameter:

SCRIPT

device1: aPlusB(10, 20, &aReg1);

device1: aPlusB(aReg1, 20, &aReg2);

cReg and vReg are used in the same manner.
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14.3    ZScript Utility Functions

14.3.1    ZScriptUintCast()

This function must be used when a function returns an 8-bit or 16-bit value to cast it into a 32-bit value for further
use. If the ZScriptUintCast function is not used, the value could be incorrect when used in subsequent functions!
The function takes 4 parameters:

• Number of bytes in the source register value

• Number of bytes to cast it to in the destination register
• A pointer to the source register

• A pointer to the destination register
This is illustrated in the following example, where an 8-bit version of aPlusB is used:

SCRIPT

device1: aReg1 = aPlusB_8Bit(10, 20);

device1: ZScriptUintCast (1, 4, &aReg1, &aReg2);

device1: aReg3 = aPlusB_32bit(aReg2, 20);

14.3.2    GetAReg() and SetAReg()

If a result value needs to be passed to a subsequent function on a different device, then the value can be
transferred by using a special register on the management station, called pcReg. The GetAReg() function is used to
retrieve the value from the first board, and the SetAReg() function is used to set the value on the second board. The
GetAReg() function has the following parameters:

• The aReg to retrieve
• The return value must be pcReg. 

The SetAReg() function takes the following parameters:

• The address of the aReg to set
• pcReg

The following example illustrates this mechanism. The example takes the result of an addition on the first board and
passes it as a parameter to an addition on the second board:

SCRIPT

device1: aReg1 = aPlusB(10, 20);

device1: pcReg = GetAReg(aReg1);

device2: SetAReg(&aReg1, pcReg);

device2: aReg2 = aPlusB(aReg1, 20);
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15.0    The Event Log

Figure 44 - Event Log Display

The event log keeps track of all the packets sent and received by the management station, both SNMP and ZLink.
To hide/show the event log window, select View -> Event Log. The event log window is split into two sections; the
top section lists the packets, newest at the top, and the bottom section shows a decoded display of the information
in the packet (SeeFigure 44). For SNMP packets, the packet is broken down into its various fields for ease of
understanding. For Zlink packets the type of packet and sub-frames are displayed.

To clear the event log, select the menu item Tools -> Clear Event Log.

The event log can be saved to disk in ASCII format.
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16.0    The Zarlink System Logger

Figure 45 - Syslog Application Configuration Dialog

The Zarlink system logger is a separate program which is run on a PC, and is used to capture debug information
sent from an agent. The user must specify a filename to pipe the captured text into, and a port number to listen to
packets on (Figure 45). This port number must match the port number setting for the agent that packets are being
captured from. To set this value, see “SysLog Configuration” on page 14.When the user selects ‘Start Capture’ the
file and port are opened. The user can empty the file at any time by clicking on ‘Reset File.’ When the capture has
finished, the captured text can be viewed in Notepad by clicking on ‘View File’. An example of a capture file is
shown in Figure 46.

Note that if the user wants to capture output from multiple boards simultaneously, multiple instances of the system
logger can be run, each one with a different port and filename. 

Figure 46 - Sys Log Capture File 
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18.0    Glossary

SNMP Simple Network Management Protocol

MIB Management Information Base

Agent Entity which can be managed over a network using 
SNMP

Management Station Network entity which manages one or more agents 
using SNMP

CET Circuit Emulation Timing

OBRS Out-of-Band Remote Signalling

ZLink Zarlink Proprietary communication protocol

ZScript Script containing remote function calls which are 
encoded using ZLink

BER Bit Error Rate
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